cam _/Z/tech

The MotionWatch User Guide

Applicable to MotionWatch 8,
MotionWatch R (Wrist),
MotionWatch R (Loop)

Document Reference: 30147
Version: 1.3.17

Date of current version: 06/01/2021

The MotionWatch is a Class | Medical Device (EU)

Covering the following product variants:

Model ‘ Cat Ref Notes
MotionWatch 8 04-111 Actigraphy & Light recording
MotionWatch R (Wrist) 04-121 Ruggedized, wrist mount
MotionWatch R (Loop) 04-125

Ruggedized, collar (loop) mount

Variants hereafter referred to as ‘MotionWatch’ for simplicity

Please visit www.camntech.com/reqister to register your software.
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MotionWatch Regulatory Information

Medical Device Regulation (European Union)
The MotionWatch is a Class | Medical Device conforming to the
requirements of Regulation (EU) 2017/745 (MDR). An EC Declaration

of Conformity will be provided upon request.

Authorised Representative (European Union)

Qarad EC-REP BV
Pas 257
EC REP 2440 Geel
Belgium
Manufacturer:
CamNtech Ltd Tel: 01480 831223
Manor Farm Fax: 01480 831733
Fenstanton Email: admin@camntech.co.uk
Cambridgeshire Web: www.camntech.com
PE28 9JD, UK

US FDA status

The MotionWatch is FDA cleared for prescription use only with FDA
510(k) number K132764. USA designated agent:

CamNtech Inc.
630 Boerne Stage Airfield,

Boerne, Phone: +1 830-755-8036
Texas 78006, Fax: +1 830-755-8085
USA Email: inquiry@camntech.com

Australian TGA

The MotionWatch has been cleared by the Australian TGA and is
listed on the ARTG with ref no: 219452

Australian Sponsor: Please note that the sponsor should be
contacted ONLY to report adverse events — all sales and support
issues must be directed to CamNtech in the UK.

Emergo Australia
Level 20

Tower Il, Darling Park
201 Sussex Street
Sydney, NSW 2000
Australia

MotionWatch & MotionWare User Guide: Issue 1.3.17 Page 2


mailto:admin@camntech.co.uk
https://www.camntech.com/
mailto:inquiry@camntech.com

IMPORTANT SAFETY INFORMATION

WARNINGS
¢ Devices removed from subjects must be considered to be

contaminated — see Appendix C.

Safety Classification Information:
¢ MotionWatch is INTERNALLY POWERED EQUIPMENT.

¢ Coin cell battery — potential swallowing hazard for small
children!

¢ Not defibrillation proof.

¢ Not indicated for use on areas of broken or irritated skin. The
MotionWatch Rugged metal casing contains nickel.

¢ MotionWatch mode of operation is CONTINUOUS OPERATION.
e MotionWatch is for PRESCRIPTION USE ONLY (Rx Only) - USA.

Device and Packaging Symbols and Markings:

MEANING SYMBOL DESCRIPTION
General Warning A Potential hazard - refer to the warnings in
the instructions for use (i.e. this user guide).
Consult Instructions | @  This symbol indicates that important
for Use ‘ ~ 1 operational information is contained in the

user instructions (i.e. this user guide).

Ingress Protection
Rating

IPX7

The MotionWatch is suitable for temporary
immersion in water (up to 1 hour at 1 meter
depth).

Serial Number

This number provides a unique identification
for a particular device. Always quote this
number when seeking technical assistance.

Catalogue Number

This number identifies this particular variant
of the product range.

Manufacturer and Date
of Manufacture

This symbol is accompanied by a date in
the format yyyy-mm which indicates when
the device was manufactured. The symbol
is also accompanied by the address and
contact details of the manufacturer

Electrical Safety
Classification

The MotionWatch is a TYPE B APPLIED
PART.

Medical Device

The MotionWatch is a Medical Device.
Medical Device Regulation 2017/745.
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IMPORTANT BATTERY ADVICE

Battery Replacement

The MotionWatch operates at very low power. When the battery is removed, the
watch requires some time to fully reset.

It is essential that the battery replacement process is observed
fully to ensure that any new battery is correctly registered in the
watch.

Do not fit a new battery without observing the correct
procedure as detailed in Appendix A4.

Always use a new, retail packaged battery — never re-use a part
used battery.

Always choose a quality branded battery — budget brand batteries have much lower
energy and can significantly reduce performance. CamNtech recommends the
battery is removed if the device is not used for a period of more than 30 days, in
order to prevent potential damage from battery leakage. Observe the storage
information below for the removed battery.

Failure to observe the correct procedure may result in loss of data.

Battery Storage
The MotionWatch uses a CR2032 coin cell battery:

NEVER Store loose batteries together — they will short and
may generate heat.

Shorted batteries can no longer be used and should NOT
be fitted to the MotionWatch.

Poor storage may result in loss of data.

Choking/Swallowing
Hazard
NEVER allow young children to have access to an open

MotionWatch as the battery may be a choking or
swallowing hazard.

In normal use the watch closure should be sufficient to
prevent a child opening and accessing the battery.

If the case lid becomes loose, do not use the watch with
young children and seek assistance from CamNtech.

FOR FURTHER HANDLING & ENVIRONMENTAL INFORMATION PLEASE
REFER TO APPENDIX C
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1 Introduction to the MotionWatch

1.1 An Overview of
the MotionWatch

The MotionWatch is a compact, lightweight, body-worn
activity monitoring device that may be used to document
physical movement associated with applications in
physiological monitoring. The device is intended to monitor
limb or body movements during daily living and sleep. The
MotionWatch can be used to assess activity in any
instance where quantifiable analysis of physical motion is
desired. MotionWare allows for the set-up, download and
analysis of data captured with the MotionWatch. The
MotionWatch also incorporates a light sensor to record
luminous intensity (lux) of white light and an event marker
button. Utilizing the latest low-power MEMs technology,
the MotionWatch provides a convenient, flexible platform
for Actigraphy studies of all sizes. See Appendix D for
technical and operational specifications.

Components Required for a System

The MotionWatch 8

A MotionWatch system consists of two elements:

e One or more MotionWatch devices.

e PC or Mac based MotionWare Software providing set-
up, download and analysis functions.

Note that no reader or interface is required — the
MotionWatch has a direct USB connection.

Light sensor Event Marker Button

Status Indicator

Event Marker: The MotionWatch 8 has a front-panel button
that may be pressed by the subject to mark specific
events. Typically this will be used to mark when the subject
goes to bed and when the subject gets up in the morning.
The use of the marker will insert a date/time stamped mark
within the data.
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Light Sensor: The MotionWatch 8 has a front-panel
ambient light sensor which can optionally be enabled to
collect indoor or outdoor light exposure. This function is
also useful to observe the ‘lights out’ period during sleep.
Status Indicator: Provides visual feedback by flashing
when the event marker is pressed. Also used to indicate
USB connection and during the battery replacement
process.

Opening the MotionWatch 8 Casing

The MotionWatch 8 utilises a ‘twist-lock’ casing which
provides a waterproof seal for the electronics and USB
connection while facilitating easy access to the battery.

To open the casing, grasp the front of the watch by the two
finger grips and rotate anti-clockwise by approximately
15 degrees to release.

WARNING!

DO NOT ATTEMPT TO FORCE OPEN/CLOSED THE
MOTIONWATCH CASING WITHOUT TWISTING TO
UNLOCK/LOCK. DOING SO WILL DAMAGE THE
CASING AND INVALIDATE THE WARRANTY!

Now gently lift out the front section of the casing...
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Then turn over to access the USB connection...

USB Connection

When the MotionWatch is connected for the first time, the
USB drivers will automatically be installed (see Section 2.5
Installing the USB Drivers).

Closing the MotionWatch 8 Casing

The casing must be closed with the parts correctly aligned.
To aid with alignment, coloured indicators have been
provided as shown in the figure below:

Alignment Indicators

With the indicators aligned, drop the top part of the casing
into the lower part and then turn clockwise by
approximately 15 degrees to close.

WARNING!

DO NOT ATTEMPT TO FORCE OPEN/CLOSED THE
MOTIONWATCH CASING WITHOUT TWISTING TO
UNLOCK/LOCK. DOING SO WILL DAMAGE THE
CASING AND INVALIDATE THE WARRANTY!

MotionWatch & MotionWare User Guide: Issue 1.3.17 Page 10



1.2 MotionWatch
Rugged Model

e

S
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The MotionWatch R (Rugged) is a ruggedized version of
the standard MotionWatch intended for use in harsh
environments such as veterinary or military applications.
The electronics are identical to the standard MotionWatch
but the casing is all-metal to provide additional strength
over the standard plastic casing. The Rugged case does
not include the marker button or light sensor.

Opening the MotionWatch Rugged Casing

The MotionWatch R casing is secured with four Philips
head screws. To open the casing, carefully remove the
four screws using the micro screwdriver provided (See
photo). Take care not to lose the screws.

CamNtech recommends that ONLY the provided
screwdriver (part number C92-0013) is used for this
purpose:

Gently lift away the front cover taking care not to lose or
damage the O-ring seal.

The electronics module is enclosed within a plastic
housing (see photo below).
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Electronics Module

O-ring seal

Now simply lift out the electronics module to reveal the
USB connector and the battery:

USB Connection

When the MotionWatch is connected for the first time, the
USB drivers will automatically be installed (see Section 2.5
Installing the USB Drivers).
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Closing the MotionWatch Rugged Casing

To ensure that the MotionWatch R maintains correct

accelerometer orientation, the casing has two alignment
features.

e Features on the plastic electronics module housing.
e Alignment screw on the casing lid.

Insert the electronics module into the lower casing and
ensure that the features on the plastic part are aligned as
shown with the yellow highlight below. Note also the
position of the alignment screw highlighted in red below:

Features on the
plastic fit into the
recesses inside
the lid

Alignment screw
fits into the recess
on the lid

Inside
view

of lid

With the internal features correctly aligned, gently press
the lid down; it will fit with a positive click and be aligned
flush with the lower casing if the alignment is correct.
Finally re-insert the four Philips head screws and tighten
down gently — use only the supplied screwdriver, and do
not over-tighten as the thread may be stripped!
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1.3

Intended Use

The MotionWatch is a compact, lightweight, body-worn
activity monitoring device that may be used to document
physical movement associated with applications in
physiological monitoring. The device is intended to monitor
limb or body movements during daily living and sleep. The
MotionWatch can be used to assess activity in any
instance where quantifiable analysis of physical motion is
desired.

NOTE: the device software should not be used directly
for diagnostic or therapeutic decision making.

1.4 Contraindications

15

1.6

1.7

Patient
Population

Required Skills,
Training &
Knowledge of
Intended Users

General
Description of
Use

The MotionWatch is indicated for use on healthy,
undamaged areas of skin. Where the patient has a history
of skin irritation, a device should be worn for a brief period
to test for skin irritation prior to commencing any recording.
Any device in close contact with the skin can trap sweat or
moisture and cause redness or slight skin irritation. If this
occurs, remove the watch and do not wear it for 2-3 days
to allow the irritation to clear.

There are no restrictions on the intended patient
population for the MotionWatch devices.

It is intended that the device be administered only by duly
gualified health care professionals, researchers and or
trained nursing staff, possibly in a hospital environment.

The MotionWatch contains a miniature accelerometer to
allow measurement and recording of physical movement of
the wrist which provides a close correlation to whole body
movement. The data are sampled at 50Hz and processed
into ‘epochs’ of user selectable length. These data are
stored into an internal non-volatile memory and then
downloaded for analysis at the end of the study period.

Data recorded by the MotionWatch may be downloaded
and analysed off-line using the MotionWare software.
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1.8 Inspection
Before Use
The MotionWatch (including strap) shall be inspected for
signs of damage or wear before each use. Do not use the
device if the inspection reveals any damage.

Contact CamNtech UK or your local representative if you
suspect your MotionWatch device(s) may have sustained
damage.

1.9 Service Life
The recommended service life of the MotionWatch devices
is 5 (five) years.

1.10 Modifications
DO NOT ATTEMPT TO MODIFY THE MOTIONWATCH
IN ANY WAY. Doing so may affect device safety and/or
performance, and will nullify any remaining device
warranty.

1.11 Adverse

(Serious)

Events
Any and all serious/adverse events which result in patient
harm MUST be reported to CamNtech and your national
Competent Authority. Refer to guidance provided by your
local legal authority for information on reporting procedures
and timescales.
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2 MotionWare Software Installation & Settings

2.1 System
Requirements

The MotionWare software is provided via download (A
USB stick can optionally be provided at extra cost). The
installer contains all of the components required to install
the software package. The following are the minimum
requirements of a Windows PC for installing the
MotionWare software:

e Windows® 8 or 10, 32 or 64bit operating systems.

e 2GHz + processor speed recommended

¢ 500 MB available disk space

e One free USB port

e SVGA graphics card (1280 x 1024) recommended

CamNtech recommends the following minimum security
requirements for the host PC:

e Use of strong user login passwords

¢ Enabling of automatic Windows updates

e |f the host PC is networked, use of Windows
Firewall (or third-part alternative) — ensuring
updates applied

e Use of Windows Defender anti-malware (or third-

party alternative) with automatic definitions updates
enabled.

The MotionWare software is also available for Mac
computers, where the minimum requirements are:

e macOS 10.13 or greater.

¢ 500 MB available disk space

e One free USB port. The MotionWatch will be
supplied with a rectangular USB “Type A” cable.

You will need a standard adaptor to connect this to
some USB-C only devices.

CamNtech recommends the following minimum security
requirements for the Mac computer:

e Use of strong user login passwords
¢ Enabling of automatic operating system updates

CamNtech recommends that the MotionWatch is not
connected to any PC other than a dedicated host PC
which meets the above requirements and is running the
MotionWare software. The MotionWatch is powered by a
replaceable battery, so there is no need to plug it in
elsewhere in order to charge.
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2.2 Software Registration

To access the MotionWare software download, it is
necessary to first register the software with CamNtech.
Please visit www.camntech.com/reqister to register your
software using the reference number provided with your
equipment. You will then be provided with a username and
password allowing log-in and download of the software at
any time during the two year warranty period.

Note that CamNtech standard software licensing allows up
to 3 users to register and use one copy of the software.
You will also be provided with a software serial number
that will be required to activate the software following
installation (see section 2.6 below)

The software will continue to be fully functional beyond the
warranty period but updates will no longer be provided.

2.3 Software Installation

2.4

2.5

Updating the
Software

Installing the
USB Drivers

To install MotionWare for Windows, download the installer
(.msi) from the CamNtech website:
www.camntech.com/downloads

Double click on the downloaded .msi file to run the installer
then follow the installation process. A message warning
that ‘Publisher cannot be verified’ may be displayed — click
‘Run’ to accept (this is a Windows security warning and is
not a problem). Note that the software requires the
Microsoft .NET Framework 4 to operate — this will be
automatically installed if not present.

To install MotionWare for Mac, download the installer
image (.dmg) from the CamNtech website:
www.camntech.com/downloads

Double click on the downloaded .dmg file to open the
installer image. This will display an icon for the
MotionWare software alongside the icon for your
computer’s Applications folder. Drag the MotionWare icon
onto your Applications folder to install.

For software versions 1.2.1 and higher, it will not be
necessary to remove the old software before installing a
new version. Note that any data and settings are not lost
during re-installation.

This section on installing drivers only applies to new
installations.
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2.6 Software Serial
Number

e The MotionWatch utilises generic USB drivers
which are provided as part of the Windows and
macOS operating systems.

e Toinstall the drivers, attach the supplied USB
cable to a free USB port and connect to the
MotionWatch.

e If your Mac or PC only includes USB-C ports, you
will need to use an adaptor in order to connect the
rectangular USB-A plug for the MotionWatch.

e Depending upon the version of Windows, a
sequence of messages similar to that shown below
may be displayed at the bottom of the screen:

i) Found New Hardware
MWa

N

i) Found New Hardware
Your new hardware is installed and ready to use.

If prompted, you may be required to restart the PC.

The driver installation is now complete.

Double click on the MotionWare icon on the Windows
desktop or start menu to start the software, or select
MotionWare from Launchpad on your Mac.

The software will run for a 30 day evaluation period, after
which the software serial number will be required.

If you do not already have a serial number you will need to
register the software. To check or enter the software serial
number, open the Settings window (=->Settings), then
click ‘View or enter software serial number’. To initially
register, please click the ‘Get Serial Number’ button to link
to the CamNtech website (note: you will need the
reference number supplied on the CD or media).

When you have received your serial number, enter the 8
digits and then click the ‘Apply Serial Number’ button.

Serial Number...

MotionWare Software

Serial Number:

| Cancel | | Get Serial Number
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2.7 Running the
Software —
Main Screen

2.8 MotionWare
Settings

Double click on the MotionWare icon on the Windows
desktop or start menu to start the software, or select
MotionWare from Launchpad on your Mac. If a
MotionWatch is connected it will be automatically detected
and the MotionWatch Manager screen will be displayed.
The front screen of the software with no MotionWatch
connected will be similar to that shown below:

€ MotionWare 1.3.12 - O X
¢ : oy
MotionWare 1.3.12
www.camntech.com

demodata A
TomNoSetupCB
TomNoSetupCB3
TomNoSetupCB2
Homemac 2sec
Tom home mac3
Tom home mac
Tom home mac2

Sleep & Circadian Rhythym Physical Activity Analysis HS Battery 3
HS Battery 3
Chair NewBatt B
Chair NewBatt

-, I I - d iy

Tom

USB D Buk Sett hises

levice Export ings Tom day
Tom Demo v
Browse..

Click on the Settings button on the start-up screen to open
the MotionWare settings window:

[ JON ] MotionWare Settings

View or Enter Software Serial Number

Institution name (for printouts):
Manor Farm Mac

Default Action for Recent Items Double-Click: Sleep Analysis

Warn if new Firmware available

Automatically show the MotionWatch Manager window when a MotionWatch is connected

Updates
Check for Update

Automatically Check for Updates to MotionWare
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View or Enter Software Serial Number

Set Institution Name

Click this button to open the serial number entry window,
described in Section 2.6 above

You may also choose to enter an institution name in the
settings window, which will then be included near the top
of all printed reports. This may be desirable if you wish to
hand the actogram or other reports directly to participants
after use.

Default Action for Recent items

Choose whether to open the data with either Sleep
analysis or Daytime Activity Analysis upon double click in
the recent items list.

Warn if new Firmware available

New firmware (software that is programmed into the
MotionWatch) is sometimes provided within the software
update. Check the ‘Warn if new firmware available’
selection to be automatically notified if new firmware is
available.

It is recommended to check and update the MotionWatch
firmware following software update — see Appendix A2.

Automatically show the MotionWatch Manager...

Updates

Controls whether or not to automatically show the
MotionWatch Manager Window when a MotionWatch is
connected to the computer.

The software will automatically check for updates each day
it is used, but this feature can be disabled using the
“Automatically Check...” tick box.

You can also choose to manually check for updates from
the button here. This will connect to the CamNtech website
immediately to check if updates are available

We recommend keeping your software up-to-date when
possible. Ideally, updates should be applied in-between
data collection projects and avoided during them unless
there is a specific need.
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3 The MotionWatch Manager

3.1 MotionWatch
Current Set-up

With the MotionWare Software already started, connect a
MotionWatch to the USB cable; the watch will
automatically be detected and the ‘MotionWatch Manager’
screen will be displayed as shown below:
ESNEE

£} MotionWatch Manager

CURRENT SETUP INFORMATION Full Name
Gender M Date of Bith  13/02/2018

Details of the current set-up stored in the
MotionWatch. Stat On  13/02/2018 A 12:20
MationWatch Mode 1
Light R ing Enabled Compression OFF
Body ion  Unspecified
‘ecording Length 28440 Samples {4 Days, 22 Hours, 30 Mins)

Setup Watch: click to start a new
MotionWatch setup (Section 3.2)

Status

Read Data: click to download the data from

the MotionWatch (Section 4.1) S— SR
Setup

Curent Setup_ - Utiities =

Battery Life

Exit: Close the MotionWatch Manager
window.

UTILITIES TAB

Click to view/edit advanced functions
(Appendix A)

If a MotionWatch is connected but the above screen is not
shown, click on the ‘MotionWatch Manager’ button on the
front screen.

The MotionWatch Manager screen is automatically closed
when the MotionWatch is disconnected.

The MotionWatch setup options will be explained in detall
in the following section.
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3.2 Applying a
New Set-up

Click the ‘Setup Watch’ button, the new setup tab is
activated and the settings may now be edited:

User ID: Enter characters to identify the
subject/patient/study.

Full Name: [optional] Enter characters to identify
the patient/study. Note that the maximum length is
64 characters shared between user ID and Full
Name.

Gender: Use the dropdown to select M, F or X (if
gender is to be undisclosed).

Date of Birth: Use the date control to enter the
date of birth of the subject.

Start Date & Time: Select delayed start to begin
a recording up to 30 days in the future. Immediate
start will begin in 1-2 minutes after disconnection.

Recording Mode: Use the drop down control to
select the recording mode.

Light Recording: Check the box to enable light
recording (Not available on rugged model).

Compress Data: Check the box to compress the
activity data (see below).

Body Position: Choose the mounting location of
the MotionWatch.

Epoch: Use the drop down to select the required
recording epoch.

Recording Length: Shows the expected
maximum length of the recording based upon the
chosen settings.

Battery Life: Indication of approximate battery life
remaining in % and colour coded battery gauge.
Hover over with the mouse for more information.

Disable Marker Button: Allows the event marker
button to be disabled. (Not available on rugged
model).

Apply Setup

WA MotionWatch Manager

ser/Patient ID 9995001234
Full Name A Subject
Gender M

-

Date of Bith  26/07/1930 [E]-
Immediate Start @ Delayed Start

19/02/2018 [E~ L A 10

-

Statt On
Recording Mode | MationVWatch Mode 1
+| Recond Light

Compress Data

96 %
45 Days and 12 Hours
= Marler Button

Battery Life

Ltilities

New Setup

NOTE: The software will warn if data has not been
downloaded when applying a new setup. If the data are
NOT required, select ‘Yes’ to continue the setup. If the
data are required, select ‘No’ and then download the

data.

Having entered your required setup information, click the
‘Apply Setup’ button to write the setup to the watch.
Observe the message window for the confirmation
message and then disconnect the watch. If any setup
warnings are shown, consult the troubleshooting section in

Appendix B.

Immediate or Delayed Start

Select ‘Immediate Start’ to ensure that the MotionWatch
begins recording straight away. The start date and time are
taken from your computer clock so please ensure that
this is correct. A delay of up to 2 minutes is added to the
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Recording Mode

Body Position

Epoch

Light Recording

current time and the recording will start on a complete
minute. If for example the set-up is applied at 16:46:27, the
delay will be one minute and 33 seconds and the recording
will begin at 16:48:00.

Select ‘Delayed Start’ to show the start date/time controls.
This option allows the recording to be delayed for up to 30
days into the future. Use the date, hours and minutes
controls to select the required start date and time.

The MotionWatch offers the following recording modes:

e MotionWatch Mode 1 — This is an epoch based
recording mode designed to produce similar
behaviour to legacy Actiwatch and similar products,
using a single axis algorithm and peak detection.

e Tri-Axial Mode 3 — This is an epoch based
recording mode that uses all three of the
accelerometer axes to produce a vector magnitude
result per epoch. This mode is used for recording
daytime activity when the watch can be mounted at
other locations on the body (See body position
below). Note that this mode will shorten the battery
life as there is more data processing.

For daytime activity analysis it is recommended to note the
location upon the body where the MotionWatch is
mounted. The physical mounting position will have an
effect upon the data (e.g. data from the wrist will differ from
that recorded at the waist). This is an optional field that
does not affect the data recording and processing, only
post-recording physical activity analysis. It can be changed
after a recording is changed if necessary, using the
physical activity analysis function, but is better noted at the
time of setting up

The epoch is the duration for which the MotionWatch will
accumulate samples before storing the result in memory.
For example, using a 1 minute epoch, one result will be
stored in memory every one minute. The MotionWatch
offers the following epoch length options:

1, 2, 5, 10, 30 and 60 seconds.

Note: the algorithms used for sleep analysis are validated
using a 30 second epoch.

The MotionWatch has a built in ambient light sensor. Light
recording may be enabled or disabled by checking or
unchecking the ‘Record light' checkbox during setup.
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Recording Lengths

Battery Life Gauge

When enabled the MotionWatch will store light values in
lux at the same epoch as the activity samples. The light
sensor records white light with a response optimised to
match the human eye. The light is sampled once per
second and averaged over the epoch. The results are
stored as lux values.

Light recording is not available on the MotionWatch R
(Rugged) model.

The MotionWatch calculates and displays the expected
recording length as the settings are changed. The
recording mode, epoch, light settings and compression will
all affect the maximum recording length. The following
table provides the recording lengths for MotionWatch
Mode 1 recording.

Epoch Activity Activity & Activity
(Seconds) Only (days) Light (days) Compressed*
1 3 15 6
2 6 3 12
5 15 8 30
15 45 23 90
30 91 46 91
60 91 91 91

*see below for details of data compression

Note that the maximum recording time is limited to 91 days
(MW Mode) and 60 days (Tri-axial mode) due to battery
life.

The MotionWatch Manager screen shows the battery life
gauge to provide an indication of remaining battery life
using a colour coded bar. The bar will change colour to
provide a clear indication of battery status as the battery
becomes depleted. The battery life gauge has the following
indications:

Green 60% to 100% 54 to 91 days (MW Mode)
36 to 60 days (Tri Mode

Baﬂew Lfe

Yellow 40% to 59% 36 to 53 days (MW Mode)
24 to 35 days (Tri Mode

Battery Life  mu——

Orange  20% to 39% 18 to 35 days (MW Mode)
12 to 23 days (Tri Mode

Battery Life  m—

Red 0% to 19% 0 to 17 days (MW Mode)
0to 11 days (Tri Mode)
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Battery Life

Compress Data

Disable Marker Button

Battery Life

WARNING! - Battery life is below 15%

When the battery life falls below 15%, the software will
warn the user to try and avoid potential loss of data.

ALWAYS REPLACE THE BATTERY IF THE RECORDING
IS LONGER THAN THE EXPECTED BATTERY LIFE.

If set-up is attempted with a short battery life, an additional
warning message will be displayed.

The MotionWatch uses a standard non-rechargeable
CR2032 coin cell which is easily replaced by the user (see
Appendix A4). The MotionWatch incorporates smart
battery monitoring to measure actual device usage and
battery voltage to calculate an expected life remaining.
Typically the expected battery life will be 3 months
(MotionWatch Mode) or 60 Days (Tri-axial Mode) and the
battery life indication will provide a percentage of life
remaining. Hovering over the battery life in either the
current or new setup screens will show the expected
battery life in days in the information pane of the
MotionWatch Manager.

The MotionWatch monitors several parameters to
automatically detect when a new battery is fitted.

The watch will shut down when the battery is depleted —
light recording will cease before activity recording.
Other factors such as operating temperature can
significantly reduce the battery life.

The MotionWatch requires some time to shut down fully
and restart when the battery is replaced. Always follow the
steps for battery replacement in Appendix A4. The correct
battery replacement process is CRITICAL and data
may be lost if not completed correctly.

It is possible to compress the activity data to allow longer
recordings at shorter epochs. The light data are not
compressed. The function uses a logarithmic compression
which provides lower accuracy with higher values
(quantized data). At low levels, the accuracy is not affected
hence for sleep analysis the compression function will
have minimal effect upon data. Note that the validations
were performed without data compression.

Select to disable the marker button. Not available on the
MotionWatch R (Rugged) model, where there is no marker
button available.
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Recommended Setup for Sleep Recording

The recommended settings for sleep recording are:
e MotionWatch Mode 1
e 30 second epoch

These are the settings with which the validation studies
were performed. It is possible to use other settings if
required including tri-axial mode.

Recommended Setup for Physical Activity Recording

The recommended settings for physical activity / daytime
activity recording are:

e Tri-Axial Mode 3

e Any epoch

Also set the body position during set-up so that this is
noted within the data. This may be modified after data
download (within the physical activity analysis function),
but is best captured at the point of mounting the device to
avoid errors.
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4 Downloading Data

4.1 MotionWatch
Download
Connect the MotionWatch and then from the MotionWatch
Manager Window click on the ‘Read Data’ button. The
download will begin and the progress notification will be
displayed...

Download Progress...

If the data download is not required, click the cancel button
and the operation will be aborted.

When the all data has downloaded (full memory will take
less than 1 minute) the ‘Save Recording...’” dialog will open
to allow the data to be saved.

Note that the recorded data in the MotionWatch is not
erased after download; It is only erased when the watch is
set up again.

4.2 Saving
MotionWatch
Data
Upon completion of the download, the ‘Save Recording...’
dialog will open automatically to allow the data to be

saved.
ot Save recording.. ﬁ
e P — - =
VAT .« VB » MotionWatch8 PC » Test Data ]
Organize = Mew folder Bz~ Eéﬁl
T Narne Date modified Type Size
il Bl Desktop || calz.mtn 25/0 MTN File 6 KB
4 Downloads || lightd.mtn 24/0 MTN File 66 KB
1 Recent Plac || Howard Light and Activity.mtn 23 MTM File 49KB |2
| misc on ftp & | bench.mtn 22 MTM File 83KB
& My Docum | Light test.mtn 21, MTN File 22KB
|| Japanese.mtn 18/0 MTN File 5KB
4 Libraries || finnish.mtn 18 MTMN File 4 KB
|| Howard.mtn 18 MTN File 238 KB
1% Computer || markertest.mtn 18/0 MTN File 6 KB
% oLy (5] || TestDate USA.mtn 18 MTM File 3KB
== HP_RECOVI || TestDate UK to USA.mtn 18/0 MTN File 4KB
i L CamNtech _ R e LS i
File name:  MyData| -
Save as type: [Motion (*.mtn) V]
~ Hide Folders [ sawve | [ canca |
|

IMPORTANT! = ALWAYS MAKE REGULAR BACKUPS
OF YOUR DATA
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4.3 Shutdown after
Download

4.4 Join Files

This window allows the destination for the file save to be
specified. Type the name of the file as required and click
the ‘Save’ button. The file will be saved in the default
*MTN format. If you do not wish to save the file, click the
‘Cancel’ button to return to the MotionWatch Manager.

Note that the MotionWatch Manager will not automatically
close when the MotionWatch is disconnected if data has
been downloaded and not saved. This serves as a
reminder to save the data; you may manually close the
window if the data are not required.

The MotionWare software defaults to shut-down the
MotionWatch into sleep mode to save the battery following
download. Data will NOT BE LOST but the watch will
cease recording. It is possible to disable this function such
that the MotionWatch will continue to record following
download and disconnection (see Appendix A3).

NOTE! The MotionWatch cannot record movement data
whilst connected to the PC. If a continuous recording is
desired then the watch should be removed from the USB
cable and returned to the subject as promptly as possible.

It is possible to join (Concatenate) two MotionWatch
recordings to create a single recording. The recordings
must contain the same user details/setup and be
concurrent.

1. Load the first data file and open using the sleep
analysis function by selecting from the list of recent
recordings.

2. From the ‘file’ menu select ‘Join...’

3. Inthe file dialogue, browse and/or select the
second motion file that is to be joined to the first.

4. A save dialogue will open to allow the file name
and location for the newly joined file to be specified.

5. Click save to save the new file — both original files
will be kept unless the joined file is given the same
name (an overwrite warning will be given in this
case).

6. The new joined file may now be loaded from the
recent recordings list.

7. Any gap between the two recordings will show as
‘missing data’ and will be marked in grey.
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5 Preparing to

5.1 Selecting Recent
Recordings

Analyse Data

When data are saved following download, the file

automatically appears in the ‘Recent Recordings’ list on

the front screen of the software. The recent recordings list

provides a quick access method to the most recently
opened or downloaded files.

It is possible to adjust the recording for daylight saving —
see section 5.13 below for more information.

Click once on a file in the list to select it; more details of

the file are displayed in the information pane below. The
file can be opened after selection by clicking on the ‘Open

Recent Recordings: Click an item to
view the file details in the information
pane then open by clicking the Open
Selected Recording button.
Alternatively, double click an item to
open directly. Where a file is a legacy =~
file-type, this will be shown in the list
entry.

Open in Sleep Analysis: Click to
open the item selected in the Recent
Recordings list with Sleep Analysis.

N

Open in Physical Activity / Day
Analysis: Click to open the item
selected in the Recent Recordings list __
with Physical Activity Analysis.

Browse for Motion File: Opens file

selected recording’ button. Alternatively, double clicking on

the file will open the file directly (choose which analysis
type to open with double click in MotionWare Settings).

Right click on the file for more options.

€ MotionWare 1.3.12

demodata
TomNoSetupCB
TomNoSetupCB3
TomNoSetupCB2
Homemac 2sec
Tom home mac3
Tom home mac
Tom home mac2
HS Battery 3

HS Battery 3
Chair NewBatt B
Chair NewBatt
Tom

Tom

Test

Tom day

Tom Demo

Sleep & Circadian Rhythym Physical Activity Analysis

USB Device Bulk Export Settings

manager dialog to select a file.

Information Pane: Provides more
detail about the selected recording.

==

5.2 Managing Recent
Recordings

" Browse

Selected recording
C:\Users\Tom Evans\Documents\work\Data\demodata.mtn

If the recent recordings list becomes full or cluttered, it is
possible to remove entries from the list or to fully delete the
related file. To manage the recent recordings, right click on
the required file name in the list to show a pop-up menu
with the following options:

Open in Sleep Analysis
Open in Day Analysis
Properties

Remove From List
Show Folder
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5.3

5.4

Browse for
Recordings

Import Legacy
Recordings

e Delete File
e Clear Recent Items List

Select ‘Remove from list’ to keep the file on the disk but
remove it from the list; the file will not be deleted. Select
‘Delete File’ to remove from the list and delete the file from
the disk. A warning message will be displayed before the
file is permanently deleted.

The 'Show Folder’ button will open an Explorer window in
Windows, or a Finder window on macQOS, to show the
folder the recording file is located in.

Select ‘Clear Recent Items List’ to remove all files from the
list — the files will not be deleted.

Clicking ‘Properties’ allows the recording details to be
viewed.

It is also possible to locate and load recordings that do not
appear in the Recent Recordings list. From the main
screen, click on the ‘Browse...” button to find and select
another file. Use the folder controls to browse to the
location of the required files. Note that the default file
format is .MTN (depicting MoTioN) and this type of file will
be displayed automatically. It is possible to change the file-
type filter to browse for other file types (see below).

As certain legacy products (such as CamNtech Actiwatch)
used an open file format, it is possible to import existing
AWD format files. To import a legacy file, follow the
instructions to browse for a file in Section 5.3 above and
then change the file-type filter to ‘Actiwatch (*. AWD)’:

[Molion (*.mtn) v]
Motion (*.mtn
Activmtch - AWD |

The table below lists the compatibility with various
Actiwatch model data:

Actiwatch Model Compatibility
Actiwatch 7 Y
Actiwatch 4 Y

Actiwatch Light Plus Y
Actiwatch Mini Y
Actiwatch Spectrum s
Actiwatch 2 \&

Lt is not possible to directly open this type of file but it is
possible to export data from the Actiware Software in .csv
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format and then use the csv import utility to re-save the data
in compatible format (see Appendix E1 — CSV Import Utility).

55 The
MotionWise
Window
When a recording is opened the MotionWise window is
displayed:
€ C\Users\Tom Evans\Documents\work\Data\demodata.mtn - No data integrity check — m} e

File  View Tools

(Co3oRbian  [ECEUN 07/04/1597, 09:38:00 Select Select
Epoch: Age i Day(s)

Drag the mouse over a period in the graph to zoom in or analyse

[ A il I mLI._|]]Jl
08700 Tue 22 Apr 1600 16:00 21200

Loal Loda
03:00 06:00 09:00 Wed 23 Apr 15:00

T T
18:00

ks —— P "
0500 Thu 24 Apr 1600

09:00 Fri zﬁApr 1500

L 1
05700 0900 Sat 26 Apr 1500 18:00

0500 0500 Sun 27 Apr 1600 15:00

09:00 Mon jaApy 1500

05700 0900 Tue 29Apr 1500 1500

The MotionWise window provides a multiple-day, single or
double plotted motion graph (actogram) within a flexible,
scalable and scrollable window. The MotionWise window is
the key tool for the selection of data for more detailed
analysis. The top region of the window provides summary
patient information. The entire window may be stretched
and dragged by manipulating the corners of the window.
The window can also be maximised to fill the full screen by
using the window control.
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Scroll through the days by using the slider control at the
right hand side of the screen, mouse scroll wheel, or
touchpad scrolling.

5.6 The
MotionWise
Graphs
For each day containing data, a graph similar to that
shown below will be displayed.
Light Plot Event Marker No Data
Reduce (Yellow) (Blue) (Grey) Reduce
ACtiVity \ \ / \ 6750 nght
Scale \ \ o Scale
1000
500 I
ncrease
Increase .
ACtIVIty /.0 '-'I Lo 1 1.1 'Il ||||.| m O.\ nght
Tue 22 M 18:00 00:00 06:00
Scale 'U¢ ay Scale
Activity Plot
(Black)
5.7 MotionWise
Graph View
Options
The Actogram view can be adjusted for different purposes
using the window below. This is found under the ‘Options’
item in the ‘View’ menu. The Actogram will adjust to give
immediate feedback after you have changed any of the
options.
Eﬂ Actogram Options C— ST ﬁ
Row length: @® Z4hours
© 48hours
Row height: '
Start rows at: @ Eecaginning of recording
@ Fixed time:
Horizontal scale: & At top and bottom
@ Oneach row
Finer detail grid lines (subject to monitor / printer):
Annotations: @ Ful graph height
@ Only across top of graph
Row Length

Select 24 or 48 hour graphs to show single day or double
day plotted graph respectively. Each row of the graphs will
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Row Height

Start Rows at

Horizontal Scale

Finer Detail Grid Lines

Annotations

5.8 Printing the
MotionWise
Graphs

then correspond to the length chosen, but the change
forwards between rows will be 24 hours in both cases.

Using this slider, you can adjust the heights of each row of
the Actogram to show lots of detail on each graph, or very
compressed rows to present a longer time period
onscreen. Note that the range available here depends on
the setting of the ‘Horizontal scale’ below.

The MotionWise graphs default to a plot start time at the
start of the recording. However, when comparing data
between multiple users, it can be useful to have a fixed
start time for the plots. So you can select either to always
start from the beginning of the recording, or enter a fixed
time in the text box.

Using this option, you can choose to show self-contained
graphs with a horizontal scale on each row, or close-fitted
graphs with no horizontal axis on each. In the latter case, a
time scale is added at the top and bottom of the actogram
instead.

Show or hide the light grey hourly grid lines on the graphs
(these will also depend upon the resolution of the monitor
or printer).

The marker lines or highlighted periods on the graph can
be shown at full graph height or just at the top of the graph.
This can help to make the graph more clear when there
are many marker events and selected periods.

You may produce a printed copy of the MotionWise graphs
covering all days of data, by selecting the ‘Print preview”
option from the ‘File’ menu. This preview allows you to
view and step through all of the report pages using the ‘<’
and >’ buttons.

The printed Actogram can be adjusted similarly to the on
screen Actogram by clicking the ‘Actogram Options’
button. This includes an additional setting to include or
exclude a list of the recording properties with the Actogram
printout.
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5.9 Selecting the
Analysis
Period
There are three main selection options which may be
chosen by use of the control buttons in the MotionWise
window:

Select Select Select

All Day(s) Any

Select Any

The ‘Select Any’ option provides a flexible means of
selecting any analysis period between your chosen start
and end points.

In the MotionWise window, choose the period of data for
analysis by pointing at the start point, hold down the left
mouse button and then drag to select the period required.
The selected period is highlighted and the Analysis window
is automatically displayed. The figure below shows a single
overnight period selected:

2000

18:00 00:00 06:00 Sat 24 Mar

It is possible to select a very short period (i.e. a few
minutes) to several days using this method. By dragging
off the bottom or top of the MotionWise graph area, the
window will automatically scroll to allow selection of days
that are not currently displayed.

Select Days

The ‘Select Day(s)’ option will select a period starting and
ending at midnight on the chosen day(s). To make a
selection, point anywhere within the graph on the day of
interest, hold down the left mouse button and then drag to
select the day(s) required. Drag across multiple graphs to
select several days and drag off the bottom or top of the
MotionWise graph area to automatically scroll while
selecting.

Select All

The ‘Select All’ option allows a one-click selection for all
days of data ready for a multiple day analysis such as
NPCRA.
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5.10 Saved Periods

and Longer

Periods
The Analysis functions allow the selected periods to be
saved. These periods will remain highlighted in the
MotionWise Window and the analysis can be quickly re-
opened by clicking anywhere in the highlighted region. If
the saved period is longer than 24 hours (i.e. for an
NPCRA analysis) then the highlight is not shown in the
graph. These longer saved periods may be chosen from
the ‘Long periods’ menu in the MotionWise Window.

5.11 Editing Data
It is possible to edit periods where there is believed to be
some problem with the recorded data to change or remove
the activity during that period. This may be necessary
where for example the watch was not worn for a period, or
where it is believed an activity gave particularly misleading
activity counts for analysis purposes. The Edit function
may be accessed by selecting a period for analysis in the
manner described in Section 6 Sleep Analysis, then
selecting the Edit analysis function from the list in the
bottom-left of the window.

€ demodata.mtn: 23/04/1997 07:17 - 23/04/1997 19:14 - [} X

Print Preview Print...

Wed 23 Apr

Edit Data

Start of edt: | 23/04/1997 [07:25:00 | Endofedt: [23/04/1997

Change | Activity | Change data to: (O Missing data (applies to activity and light)
() Fixed value:

(O Average of Rest of day (87.8)

(® Original data

Apply Change

After selecting the Edit tool, it is possible to fine tune the
time period for the edit either by dragging the ‘Start’ and
‘End’ bars on the graph, or by changing the text boxes
containing times below the graph.
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5.12 Generating
Reports

Next you must choose to change either the ‘Activity’ or
‘Light’ channel as appropriate. Note that marking missing
data will cause both to be considered as missing.

The data samples within the selected period can be
changed in four different ways:

e Missing data — this will set the data as missing,
where the period is shown with a grey background,
and analysis functions which take an average will
ignore the missing samples.

o Fixed value — this will set the data samples (either
activity or light) to the value entered in the box.

e Average of — this will set the data samples to either
the average of the entire day (including the
selected period), or the average of the day
excluding the selected period. The day is taken as
the 24-hour period between midnights which
contains the start time of the edit.

e Original data — because all of the data and changes
are contained as an audit log within the motion file,
this option allows you to restore the original values
first recorded before any edit took place.

If the last part of the recording is marked as “Missing data”,
then this will also reduce the length of the printed
Actogram to avoid printing unnecessary missing days.
This is particularly useful if the watch has been left
recording invalid data for some time after being worn, but
before download. In this case, simply select all of the time
after the valid recording and mark it as missing data. This
can be restored at any point using the “Original data”
option above.

In the MotionWise window select ‘Tools -> Report’ to open
the report generator window. This tool provides a number
of flexible reporting options which are discussed in more
detail below. It also provides a live preview so the results
of changes can be seen immediately. If the preview
window is not open then use the “Print Preview...” button
to openit.
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€} Report (C:\Users\Tom Evans\,... — O X € Print Preview

Quick Print

Print... MotionWare 1.3.12-
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C-UsersTom Evans\Documantsing

Export Numerical Results ’
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Copy Results Tables (for Spreadsheet) g S e
: startTime 199704220938
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ﬁﬂ‘
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Report Options seriaiNoTall 0327
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¥ Include Recording Properties SitsNama 2020
steCode br2020
™ Include Markers Motion spoch (&) 53
B Transpose table from list of entries) m”fsrﬁsﬂ_m__. —
M Copy with rounded, formatted values
Fiter visible columns L Markers
List of markars (Dutions on 3 Mooy
Include Sleep Analysis 3 Namal o
Transpose table from list of entries) ﬁ::ﬁ: :;:: m:m %
M Copy with ounded., formatted values Sleep Analysis
Start aay 2
: n Day of wask Tus
Fitter visible columns Ent cay i
_ Lightsout 25
M PFrnt in Landscape o 2
Woksup 061
¥ Include Remarks Gotup 05
Time in bed art
B Spread Tables Sideways onto Extra Sheets gy 0 =
¥ Include Actogram i%: :'Nw E:‘;L ?;'5
_ Actusl waks (%) 201
M Push Actogram onto Separate Page Sieap sffickancy (%) 54
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Change Actogram Options... Soep bouta i
Maan sksap bout Ot
Maan wake Dout Ol
Immoblie mins 3482
Immobile tims (% a5
ve Formatted Report Mabie ming = =
Mabiis time (%) 141
Immobile bouts 3B
Copy to Word Processor Msan mmotiis bout 00
mmoblisboute <=tmin 3
Immobile bouts <=1min (%) 1.
Total BoOM8 G54
Save as PDF or RTF (.RTF, .DOC, .ODT)... Shoan actnaly Rapoch e
Meaan nonzaro actvity lepoch 971
Fragmentation index 354
Threshold a4

Include Recording Properties

Select this option to include the User ID, Gender, DoB,
Device information, start time and other properties within
the report.

Include Markers

Select this option to include a date/time stamped listing of
marker events within the report.

Include Sleep Analysis

Select this option to include full Sleep Analysis results for
all saved analysis periods within the report (see Section 6
Sleep Analysis).

Transpose Table

Select this sub-option to swap the row/column layout of
this specific table within the report.
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Copy with Rounded, Formatted Values

Print in Landscape

This sub-option applies to data exported via the clipboard
only. When selected, the results will contain rounded
values with periods formatted as hours and minutes. When
un-selected, the results will be exported as un-rounded
values and periods will be formatted in seconds. The latter
option is useful when importing data into external
packages for further analysis.

This option swaps the default (portrait) report format to
landscape orientation. This can be useful to best fit’ the
report to the page. This option only applies to printed
reports.

Copy Results Tables (for spreadsheet)

Copy to Word Processor

Having selected the required report options, click the ‘Copy
Results Tables’ button to export the data. The data may
now be imported into external software (e.g. a
spreadsheet) for further analysis or formatting.

Places the selected results and actograms for all days onto
the clipboard formatted to paste directly into a word
processor. This facilitates rapid production of custom
reports.

Save as (PDF, RTF, DOC, ODT)...

Print Preview

The selected results and actograms for all days are saved
into your selected file format. The available options here
will differ slightly between Windows and macOS
computers. Choose the document type in the ‘Save as
type...” dropdown, choose from the following options:

¢ RTF - Rich Text Format — open in most word
processors.

e PDF — Portable Document Format — open in Adobe
Acrobat Reader. PDF files can also be generated
from the print dialog on all supported Mac, and
most modern Windows computers.

e DOC - Microsoft Word Document.

e ODT - Open Document — use with Open Office.

Enter a file name/location to save the file. These options
facilitate rapid production of custom reports.

If you have not already opened the live preview window,
this button will do so. This will allow you to experiment with
report options and see how the resulting report presents
data and fits across multiple pages.
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Print

Having selected the required report options, click the ‘Print’
button to send the report to the printer. A standard printer
dialogue will be displayed allowing the target printer
options to be selected.

Filter Visible Columns

It is possible to further
customise the parameters that
will be included in the report.
Click on the filter visible
columns’ button for either the
marker or sleep analysis data.
A window containing a checklist
of parameters will be displayed
(sleep parameters are shown in
this example). Ensure that the
required parameters are
checked for inclusion in the
report' Mean wake bout
Immabile mins
Immabile time (%)

Mabile mins

Mobile time (%)

Immobile bouts

Mean immobile bout

Immabile bouts <=1min
Immobile bouts <=1min (%)
Total activity score

Mean activity /epoch

Mean nonzeno activity /epoch
Fragmentation Index

5.13 Daylight
Saving Adjust
If a clock change is detected (daylight saving) during a
recording, a message will be displayed upon first opening
of the recording:

r
MoticnWare — A b A - - . —, -

| There was a change in daylight savings time during this recording, based on the
current time zone infoermation. Weuld you like to apply an automatic
adjustment?

For further information, see the Tool menu.

| [ J% ]

e Select ‘Yes’ to apply a daylight saving adjustment
to the data. This will default to the local regional
settings of the computer (typically add or remove 1
hour of data at 2am.) This can be undone — see
5.14 below.
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5.14 Restore original
download

e Select ‘No’ to ignore the daylight saving adjustment
(Adjustment can be applied later if required)

It is possible to apply the daylight saving adjustment by
clicking on the ‘Tools’ menu then selecting ‘Daylight
Savings Adjust’. The following window will be displayed:

| £} Daylight Savings Adjust... Lﬂ

This function will apply an adjustment to the data related to the affectof a
change in daylight savings time. ltwill hide a period of data orinserta
"missing" period so that data from the same times of day in the wearer's local
time will line up below one another in the Actogram.

We do not recommend adjusting the data in this way. as it hides the genuine
time shiftwhich the wearer has experienced during the recording periods.
However, it may allow you to produce the simplified results you are looking
for more quickly and easily.

Daylight adjustmernt

(based on cument time zone information)

Adjustment date: 30/10/2016
Adjustment time: 0z:00
Time change (hours):

Apply now

The adjustment values will be filled in automatically where
the operating system supplied Daylight Saving Times can
be matched to the recording time period. They can
however be modified if required and then be applied to the
data by clicking ‘Apply now’.

To reverse (undo) any daylight saving adjustment or any
other edits or any saved analysis, first close the recording
and then re-open it. Then select ‘Restore original
download’ from the ‘Tools’ menu.

A warning will be displayed as follows:

r
IMotlonWare — lﬂ

I This will discard all edits and restore from the eriginal downloaded data file,

| ok || cancel

=

Click ‘OK’ to restore the original download or cancel to
keep the adjusted data. Note that all edits which have
been made to the data will be lost (including any saved
sleep periods or analysis).
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5.15 Combine Epochs
It may occasionally be desirable to convert data recorded
at a shorter epoch into a longer epoch (e.g. convert 15s
data into 30s data). The software has a built-in function to
allow this combination.

In the MotionWise window, select ‘Combine epochs...’
from the ‘Tools’ menu. A screen similar to the following will
be displayed:

&€} Combine Epochs... =NECIN X

This function will take a recording collected at a relatively short epoch, and
combine the epochs into longer ones. For example. if data was recording at
15 seconds. a lowerresolution recording can be created with a 30 or 60
second epoch instead.

Combining epochs in this way may allow you to analyse data consistently
thatwas collected in different recording epochs. ltdoes notc any new
results - it only allows creating a new recording file with lower resolution.

The resultwill be saved as a new motion file. Note that any analysis
previously performed on the file should be performed again to apply itto the
combined epoch data.

Combine epochs

Recording epoch (seconds): 1

New epoch (seconds): m
New filename: delucca20171107a_combined mtn

Browse...

Create

e

The current recording epoch will be displayed and a drop-
down control provides the available options for the new
epoch length.

The filename will default to the current file name with the
extension *_combined’ and will default to the current file
location (folder). Use the ‘Browse’ button to choose a
different file name or location. Take care not to over write
the original file as this cannot be recovered.

Note that it is not possible to convert longer epochs into
shorter epochs.

5.16 Importing Body
Temperature Data
If a recording of core body temperature has been made
alongside the motion recording using a BodyCAP
monitoring pill or similar device, you may import the data
post-recording and combine the two for display.

In order to combine the two recordings, you must first
download and open the movement recording using
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MotionWare Sleep Analysis, then select the File -> Import
Temperature... option from the menu. Choose a .csv file
exported from your temperature monitoring equipment,
and follow the options described below:

e Choose the column separator either by examining
the source data, or adjusting until a “Capsule” is
mentioned in the list below and temperature or date
options become available in the lower listings.

e Sub-table Name should present a list including the
names of different Capsules. It may include other
“table names” corresponding to areas of the .csv
file without recording data — these should not be
chosen.

e Temperature column name is the choice of column
header in the .csv file table from which to extract
temperature results.

¢ Date and Time Column names are the choice of
column header names for the date and time of
each temperature sample respectively.

After import using this window, the temperature data will
be shown in red during those time periods it is available
during the recording.

€ C\Users\Tom Evans\Documents\work\tmp\BodyCAP\BodyCap Testmtn - No data integrity .. - m] X

File View Tools

Sat 0012015 15400 pumn | —E—
Dot e 012015 Al Dayls)  Any

Drag the mouse over a period in the graph to zoom in or analyse
18:00 00:00 08:00 Thu 21 Nov

4000

3000

Note that only a narrow temperature range around 37C will
be visible on the graphs by default. This can be adjusted
via View -> Options in the menu, and then changing the
value for Body temperature range. For example, if a value
of 2 is set, the graph will include temperatures from 37-2
(35) Celsius up to 27+2 (39) Celsius.
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6 Sleep Analysis

6.1 Introduction
The Sleep analysis function is designed to provide a
number of objective sleep measures from overnight
actigraphy data. It can be easily applied either to normal
overnight periods, or used to examine any sleep period
from an altered phase recording such as a shift worker.
First select aregion using the MotionWise window
(see Section 5.9 Selecting the Analysis Period above)
which includes a short period of daytime activity at the start
and end. The detailed analysis window will be displayed
and may initially default to the summary function. To select
Sleep Analysis, choose ‘Sleep’ from the Analysis Function
options at the left of the screen. The detailed Sleep
Analysis window will be displayed:

Print Preview

Lights Ou

TR oyl e

00:00 01:00 02:00 03:00

Analysis Function: Sleep Analysis
Lights out : Gotup
Fell asleep ! Woke up

Time in bed - Assumed slesp
Actual sleep time X Actual sleep (%)
Actual wake time : Actual wake (%)
Sleep efficiency (%) . Sleep latency

Sleep bouts Wake bouts

Mean sleep bout :04: Mean wake bout
Immobile mins Immobile time (%)
Mobile mins Mobile time (3}
Immobile bouts Mean immobile bout
Immobile bouts <=1min Immobile bouts <=Tmin (%)
Total activity score Mean activity /epoch
Mean nonzero activity /epoch ¥ Fragmentation Index
Threshold

A Options l [ A Copy Results l

It is now possible to drag the ‘Lights Out’ and ‘Got Up’
markers to the appropriate positions in the data, and the
thinner red markers inside which denote ‘Fell Asleep’ and
‘Woke Up’ will be automatically adjusted from the
combination of your markings and the activity data. All of
these four times are also displayed in the information box
below the graph.

6.2 Sleep Analysis
Statistics
Once the desired sleep region is selected, the software will
automatically perform a categorisation of each epoch of
the period between ‘Fell Asleep’ and ‘Woke Up’ as either
‘Sleep’ or ‘Wake’, and also as either ‘Mobile’ or ‘Immobile’,
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and use these results to provide a number of measures
from the period. These are described below:

e Timein bed: The total elapsed time between the ‘Lights
Out’ and ‘Got Up’ times.

e Assumed sleep: The total elapsed time between the ‘Fell
Asleep’ and ‘Woke Up’ times.

o Actual sleep time: The total time spent in sleep according
to the epoch-by-epoch wake/sleep categorisation.

e Actual sleep (%): Actual sleep time expressed as a
percentage of the assumed sleep time.

o Actual wake time: The total time spent in wake according
to the epoch-by-epoch wake/sleep categorisation.

o Actual wake (%): Actual wake time expressed as a
percentage of the assumed sleep time.

e Sleep efficiency (%): Actual sleep time expressed as a
percentage of time in bed.

e Sleep latency: The time between ‘Lights Out’ and ‘Fell
Asleep’.

e Sleep bouts: The number of contiguous sections
categorised as sleep in the epoch-by-epoch wake/sleep
categorisation.

¢ Wake bouts: The number of contiguous sections
categorised as wake in the epoch-by-epoch wake/sleep

categorisation.

e Mean sleep bout: The average length of each of the sleep
bouts.

¢ Mean wake bout: The average length of each of the wake
bouts.

¢ Immobile mins: The total time categorised as Immobile in
the epoch-by-epoch mobile/immobile categorisation.

e Immobile time (%): The immobile time expressed as a
percentage of the assumed sleep time.

e Mobile mins: The total time categorised as mobile in the
epoch-by-epoch mobile/immobile categorisation.

e Mobile time (%): The mobile time expressed as a
percentage of the assumed sleep time.

e Immobile bouts: The number of contiguous sections
categorised as immobile in the epoch-by-epoch
mobile/immobile categorisation.

¢ Mean immobile bout: The average length of each of the
immobile bouts.

e Immobile bouts <=1min: The number of immobile bouts
which were less than or equal to one minute in length.

e Immobile bouts <=1min (%): The number of immobile
bouts less than or equal to one minute expressed as a
percentage of the total number of immobile bouts.
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6.3 Saving or
Removing
Analysis
Statistics

Total activity score: The total of all the activity counts
during the assumed sleep period.

Mean activity /epoch: The total activity score divided by
the number of epochs in the assumed sleep period. Note
that this result will be expected to scale depending on the
length of the epoch.

Mean nonzero activity per epoch: The total activity score
divided by the number of epochs with greater than zero
activity in the assumed sleep period. Note that this result
will be expected to scale depending on the length of the
epoch.

Fragmentation Index: The sum of the ‘Mobile time (%)’
and the ‘Immobile bouts <=1min (%)’. This is an indication
of the degree of fragmentation of the sleep period, and can
be used as an indication of sleep quality (or the lack of it).
Threshold: The threshold used for analysing movement
data. The MotionWatch was validated with a threshold of
20, but this may be chosen differently depending on the
population.

Rest per 24h (%): The percentage of epochs in a 24 hour
period which would be counted as sleep if the whole period
were analysed as night time. The period runs for 24 hours
from midday to midday around the “To Bed” time of the
analysis.

Average light (lux): This measure is only present if light
was recorded. It is the average light level over the period
between falling asleep and waking up.

Central Phase Measure (mins): This is the midpoint
between “Fell asleep” and “Wake up”, expressed as the
number of minutes past midnight. For ease of normal use,
it will be negative for phase times prior to midnight but after
midday.

With the analysis for the period complete, the analysis may
be saved by clicking on the ‘Save Sleep Period’ button.
The detailed analysis window will close automatically and
the analysis period will remain highlighted in the
MotionWise window. To re-open the saved analysis,
simply click anywhere on the highlighted region in the
MotionWise window.
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If the saved analysis is no longer required, click on the
‘Delete Sleep Period’ button in the sleep analysis screen to
remove it.

6.4 Adjusting
Analysis
Threshold
The threshold used for sleep analysis can be adjusted
under the ‘Options’ button. Note that the MotionWatch
system has been validated with a threshold of 20, so this
should normally be the default choice.

6.5 Exporting
Sleep Analysis
Results
The ‘Copy Results’ button and ‘Epoch Results’ or
‘Statistics’ options will allow you to transfer either the
detailed epoch-by-epoch results or the overall statistics
easily into a spreadsheet program or similar. Simply click
the button, transfer to a spreadsheet window on your
computer, and use the normal Windows paste function to
create a table of your results.
6.6 Printing Sleep

Analysis

Results
Click on the ‘Print Preview’ button to preview the report
and click on the ‘Print’ button to send the report to the
printer.

6.7 Sleep
Summary
Table

From the MotionWise window, select ‘Sleep Summary
Table’ from the ‘Tools’ menu. This window provides a
summary of the saved Sleep analysis periods.
Furthermore, it is possible to edit the ‘lights out’ and ‘got
up’ times within this window using patient provided
information (i.e. a sleep diary).
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Sleep Summary Tabl

Lights Ot Got Lp: End Day:

Lights Out: Got Up: End Day:

Lights Ot Got Up: End Day:

®

Lights Ot Got Lp: End Day:

Lights Out: Got Up: ¥ End Day:

Lights Ot Got Up: End Day:

&

Lights Ot Got Lp: End Day:

L
=

Lights Out: Got Up: End Day:

Lights Ot Got Up: End Day:

Adding or changing times in this table will not re-analyse the
sleep. You must also revi leep period by g
from the Actogram and save the results from there.

To enter data, highlight the required time and then type in
the data in HH:MM format.

Click on ‘Save Changes’ when complete and the analysis
periods will be automatically highlighted in the MotionWise
window. Click on any highlighted period to open Sleep
Analysis. This will perform the analysis on the visible data.
After checking the data and results for any anomalies, you
must then re-save the sleep period to capture the night’s
results for the report output.

6.8 Auto-Sleep
Analysis

In addition to the manual sleep marking described above,
the MotionWare software can also automatically analyse
an entire recording to detect the periods of sleep, then
mark and analyse them ready for reporting in a single step.
Note however that this function does not replace a
professional assessment of the data for practical issues,
and is not currently validated.

Normal Use

To use the automatic sleep marking function, open a
recording in the MotionWise window, then click on the
Tools menu, and the Auto-Sleep item. This will prompt
whether you wish to delete any existing sleep periods in
the recording, which you must do in order to proceed. The
window will then present a series of configuration options
for the user to adjust if necessary. Click on the “Analyse
Now” button to proceed.

The software will now have returned to the MotionWise
window with all sleep periods marked. You may click to

MotionWatch & MotionWare User Guide: Issue 1.3.17 Page 47



examine each of them, and also use the Report function in
the Tools menu to view the overall results table from the
analysis.

For initial use, we would recommend leaving the Auto-
Sleep Configuration window with default settings. Note
that the configuration will remember any changes from
previous use; suggested values to return to are provided in
the software window.

The Auto-Sleep analysis will be most effective where the
wearer’s sleep pattern contains clear blocks of good sleep
without long waking periods. Note that it does not rely on a
daily sleep cycle, so is still suitable for shift workers or
others with irregular sleeping pattern. Some output
measures such as sleep latency rely heavily on the use of
the marker button for “Lights Out” information.

Auto-Sleep Parameter Adjustment

Several parameters are available to adjust the behaviour
of the automatic analysis if necessary to meet your needs.
These are described briefly in the Configuration window as
shown below:

&) Auto-Sleep Configuration — O *

Ve, and rEepdeuc:l 3 bl.rt may EDI'I'I':'tII'I'It‘E require rn.:rnu.:l
.:-:Ijustrn:-nt based r_-db.:cF fram the wearer ar clinical judgement. The parameters for
the automatic classfication can also be controlled below .

Sleep Activity Threshold (cpm): _ (Suggested value: 20)

The activity threshold is used both to isolate the sleep period and for the sleep analysis
itzelf in exactly the same way as when manually marked.

Minimum Sleep Fraction (%): _ {Suggested value: 60)

This percentage determines how strictly the software will allow the extension of an
ovemight period at the beginning and end. Requiring a higher sleep fraction will produce a
mare cautious (shorter) estimate of the ovemight sleep period.

Marker Button Limit (hrs): (Suggested value: 3)

Where a sleep period has been found with marker button presses near the suggested start
or end point, the time of those presses wil be used instead of automatic d on if they
are within this time perod. Within the limit, the last marker button press wil be used.

Prescan Sleep Fraction (%): _ (Suggested value: 80)

For initial detection of an ovemight sleep period, at least three hours of it must reach ar
exceed this percentage of sleep to qualify for further analysis.

Analyse Now Cancel

Sleep Activity Threshold (cpm): The activity threshold is
used both to isolate the sleep period and for the sleep
analysis itself in the same way as when manually marked.
Its value can be chosen in the same way as the High /
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Medium / Low settings for the threshold during non-auto
sleep analysis.

Minimum Sleep Fraction (%): This percentage
determines how strictly the software will allow the
extension of an overnight period at its beginning and end.
Specifying a higher number for sleep fraction will produce
a more cautious (shorter) estimate of sleep periods.
Specifying a lower number will produce a more generous
(longer) estimate of each sleep period.

Marker Button Limit (hrs): Where a sleep period has
been found with marker button presses near the suggested
start or end point, the time of those presses will be used
instead of automatic detection if they are within this time
period. It is suggested that this limit normally be left to
allow the marker button presses to override the automatic
algorithm. However, if the wearer has been pressing the
button randomly or for other reasons, you can reduce this
number (to zero if necessary).

Prescan Sleep Fraction (%): For initial detection of an
overnight sleep period, at least three hours of it must reach
or exceed this percentage of sleep to qualify for further
analysis. If your subject’s sleep is particularly broken then
you may need to reduce this fraction, but it is also likely
you will have to examine sleep manually in that case. If the
wearer is particularly inactive during the daytime, you may
need to increase this percentage to prevent marking of
long daytime rests as sleep — but again it is likely you may
need to examine manually also in this case.

Further details of the auto-sleep and conventional sleep
analysis algorithms are available from CamNtech on
request.
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7 NPCRA Analysis

7.1 Introduction

7.2 Reference

7.3 Analysis

Traditional analysis of circadian rhythms has attempted to
fit physiological indicators to a Cosine waveform shape
(Cosinor analysis). Activity-rest data do not typically fit well
with this type of analysis, hence the MotionWare software
provides the function of Non-Parametric Circadian Rhythm
Analysis (NPCRA). With this approach, we do not assume
that the data fit any pre-defined distribution. The method
used is to analyse full-days of data over several days to
determine some useful variables which are explained in
more detail below. Studies have shown that the non-
parametric variables are a valuable indicator of rhythm
disturbances caused by disease or aging and their
associated treatments.

The NPCRA analysis is based upon the work of Dr. Eus
Van Someren at the Netherlands Institute for Brain
Research e.van.someren@nin.knaw.nl

The original paper published by Dr. Van Someren is:

Van Someren, E J W, DF Swaab, C C Colenda, W
Cohen, WV McCall, and P B Rosenquist. Bright
Light Therapy: Improved sensitivity to its effects on
rest-activity rhythms in Alzheimer patients by
application of nonparametric methods.
Chronobiology Int. (1999) 16 (4) 505-518.

NPCRA analysis requires complete data from as many full
days as possible. It is not recommended to attempt
analysis with less than 7 days of data and best results are
obtained with 14 or more days.

To select the analysis days, use the ‘Select All' button in
the MotionWise screen to automatically select all available
days. Alternatively, use the ‘Select Days’ or ‘Select any’
tools to specify the analysis period (see Section 5.9
Selecting the Analysis Period).

Note also that the analysis is sensitive to periods of
inactivity when the MotionWatch has not been worn.

Having selected the analysis period, the analysis window
will be displayed. Select ‘NPCRA’ from the sidebar
functions.
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123 Summary

= Sleep
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& Edit

Analysis Function:
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Start hour of analysis

L5 Average

M10 Average

RA (Relative Amplitude)
IV {Intra-daity Variability)

Mon-Parametric Circadian Rhythym Analysis
29/05/201211:00 Length of analysis 7 days. 23 hours

L5 Start Hour
M10 Start Hour
1S (Interdaily Stability)

7.4 Non-

Parametric
Variables

The NPCRA window provides a table of resulting Non-
Parametric variables with the following meanings:

IS (Interdaily Stability): quantifies the degree of regularity
in the Activity-Rest pattern with a range of 0 to 1 where a
value of 0 indicates a total lack of rhythm and a value of 1
indicates a perfectly stable rhythm.

IV (Intra-Daily Variability): quantifies the degree of
fragmentation of activity-rest periods. Typical healthy
subjects will show a single prolonged activity period and a
single prolonged rest period per 24 hour cycle. Certain
physiological conditions may lead to multiple short-length
periods of activity-rest within any 24 hour period. The
variable has a theoretical range of 0 to 2 with higher values
indicating higher fragmentation. Typical values for healthy
subjects will be below 1.

L5 (Least 5) Average: all days of data are overlaid and
averaged in 24-hour periods. The L5 average provides the
average activity level for the sequence of the least five
active hours. This value provides an indication of how
restful (inactive) and regular the sleep periods are.

L5 Start Hour: Indicates the onset of the L5 sequence and
provides an indication of the phase of the most restful
hours.

M10 (Most 10) Average: all days of data are overlaid and
averaged in 24-hour periods. The M10 average provides
the average activity level for the sequence of the highest
(most) ten active hours. This value provides an indication
of how active and regular the wake periods are.
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M10 Start Hour: Indicates the onset of the M10 sequence
and provides an indication of the phase of the most active
hours.

RA (Relative Amplitude): First we calculate the Amplitude
(AMP) which is the difference between the average activity
level in the M10 and that in the L5 periods. To remove
sensitivity to overall activity level, we then calculate the RA
by dividing the AMP by the sum of the L5 and M10. The
variable has a theoretical range of 0 to 1 with higher values
indicating a rhythm with higher amplitude.

7.5 Replacing a
missing period
of data
Where there are short periods of missing data where the
watch was not worn, it is possible to replace the data to
ensure continuous data for NPCRA.

In the ‘Edit’ screen click and drag the start and end cursors
to the period of data required. It is also possible to type the
date/time into the ‘start of edit’ and ‘end of edit’ fields.

Next use the control to change either ‘Activity’ or ‘Light’
data.

Now select ‘Average of this period on days before & after’;
the control will display in brackets the average value for
the selected period.

Now click the ‘Apply Change’ button — the selected period
will have the data replaced with the average of the
corresponding period for the days prior to and after the
selection.

€} Howard_9.mtn: 22/11/2016 00:00 - 26/11/2016 00:00 < - - - o | B |

Print Preview

ol
00:00 Tue 22 Mov 0000 Wed 23 Nov 00:00 Thu 24 MNov 00000 Fri 25 Mov
Analysis Function: Edit Data
123 Summary Startof edit  23/11/2016 1424:00 End of edit  23/11/2016 15:40:30
= Seep d Select
‘
s NPCRA Average of
Select m 24h Average Change | Activity ~ | Change datato: () Missing data (applies to activity and light) i i
Activit = __ this perio
Clvity or = (0
y & Napping ") Fixed value: |10 on dayS
||g ht © Average of | This period on days before &after (108.2) before &

() Original data

after’
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7.6 Excluding full

days from

NPCRA
If much of any day has missing data where the watch was
not worn, it is possible to exclude the day(s) from the
NPCRA analysis. Use either ‘select days’ to choose
individual days or ‘select all’ to edit more than one period.
In the ‘Edit’ screen enter the date/time into the ‘start of edit’
and ‘end of edit’ fields using 00:00:00 for the times to
ensure full days are selected.

Select ‘Change data to: Missing data’, and click the ‘Apply
Change’ button — the selected day will be highlighted in
grey and will be excluded from any subsequent NPCRA
analysis.

This process can be repeated for more than one day.

Excluded
days
highlighted in
grey

- -\
Howard_9.mtn: 21/11/2016 16:15 - 31/1. iﬁi-s l | B |
€} Howard 9.mtn: 21/11/. 1 aad

]
Sun 27 Nov Sun 4 Dec Sun 11 Dec Sun 18 Dec Sun 25 Dec

Analysis Function: Edit Data
Startof edit  08/12/2016 00:00:00 End of edit  09/12/2016 00:00:00

Change Change datato: @ Missing data (@pplies to activity and light)

") Fixed value: |10

") Average of | All data in day (120.7)
) Original data

H

7.7 Restore
original data
The original data are not lost during the edit. To restore the
original data, use the cursors to include the edited period
then select ‘change data to: Original data’. The edited
period will be restored to the original data.

7.8 Exporting
NPCRA
Analysis
Results
The ‘Copy Statistics’ button will allow you to transfer the
overall statistics easily into a spreadsheet program or
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similar. Simply click the button, transfer to a spreadsheet
window on your computer, and use the paste function to
create a table of your results.

7.9 Printing
NPCRA
Analysis
Results
Click on the ‘Print Preview’ button to preview the report
and click on the ‘Print’ button to send the report to the
printer.

7.10 Save NPCRA

Analysis

Period
Click on the ‘Save Period’ button to save the selected
analysis. Long periods are not highlighted in the
MotionWise window as they would hide shorter periods
and become confusing. Instead use the ‘Longer periods’
menu from the MotionWise window to select any saved
periods greater than 24 hours.
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8 24 Hour Average Plot

8.1 Select Data for
Analysis

From the MotionWise window, use the ‘select days’ option
to choose a range of days or use the ‘select all’ option to
analyze all days. The analysis window will open
automatically; if not already selected, select ‘24h Average’
from the analysis functions side bar. A screen similar to
that shown below will be displayed.

f v - . Ll b
€ Tomtestmtn: 20/05/2012 11:12 - 06/06/2012 09:45 . o

Print Preview

12:00 18:00

24 Hour Average Plot

Smoothing Period:
Daytime period (for activity comparison): to

Starttime 11:12:00

End time 09:45:15

Start date 29/05/2012

End date 06/06/2012
Daytime Average Activity  74.8 MW counts
Nighttime Average Activity 25.3 MW counts
Day/MNight Average Ratio  2.95

Fitted Cosine Peak 14:18:50

Copy Activity Results ] ’ Copy Statistics

Smoothing Period

The smoothing period allows a time constant to be applied
to the plotted data which is useful when analyzing for
trends. The period may be selected between no smoothing
and 60 minutes.

Daytime Period
It is possible to specify the start and end of the daytime
period to be used for the analysis. This will affect the
daytime and nighttime average values accordingly.

Activity Average
The data per epoch for each day are day totalized and
averaged over the number of days in the analysis. The
average activity in the daytime and nighttime periods are
then calculated and displayed. Note MW counts are
MotionWatch counts.

Day/Night Average Ratio

This is the daytime activity average / nighttime activity
average.
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Fitted Cosine Peak

A cosine is fitted to the averaged data and the time of day
where the cosine peak occurs is displayed.
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9 Nap Analysis

9.1 Overview
The Nap analysis function allows detection of periods of
inactivity that could be attributed to daytime napping or
micro-sleeps. The function provides user adjustable
parameters for duration and threshold to detect the
potential naps.

9.2 Select Data for
Analysis

From the MotionWise window, use the ‘select any’ option
to a period of data to analyze — this will typically be during
the normal active daytime period. The analysis window will
open automatically; if not already selected, select
‘Napping’ from the analysis functions side bar. A screen
similar to that shown below will be displayed.

€ Howard Long TestZ.mtn: 11/11/2013 07:47 - 11/11/2013 21:53 | oS S

Print Preview

Mon 11 Nov 16:00

Nap Analysis
Searching for naps from 11/11/2013 07:47 to 11/11/2013 21:53.
Napping activity level (fepoch): 50
Minimum nap length 00:05:00
Maximum nap length 00:30:00

Possible naps found: 3

Export Nap Periods

9.3 Select Nap
Activity
Threshold
The ‘Napping activity level (/epoch)’ is used to set the
activity threshold for nap detection. The activity level in
every epoch within the specified period must be less than
or equal to the entered value for the period to be scored as
a nap. For example, if the threshold is set to 10, the period
will be scored as a nap if every epoch <=10 counts.
Change the threshold value by typing the number of
counts.
9.4 Select Min Nap
Length
Set the minimum period of inactivity required to be scored
as a nap. The value should be typed in the format
hh:mm:ss. Periods shorter than the selected value will not
be scored as a nap period.
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9.5 Select Max Nap
Length

9.6 Analysis
Results

9.7 Export Nap
Periods

Set the maximum period of inactivity required to be scored
as a nap. The value should be typed in the format
hh:mm:ss. Periods longer than the selected value will not
be scored as a nap period.

The analysis window will show the number of potential
naps detected. The analysis graph will display the potential
nap periods as green highlighted areas.

To export the nap analysis details, click on the ‘Export Nap
periods’ button. The nap analysis details will be copied to
the clipboard which may then be pasted into Excel or
similar for further analysis.
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10 Physical Activity (Day) Analysis
10.1 Overview

The physical activity analysis function provides an
overview and summary of the activity levels of the wearer
during the daytime. It is intended to assist in monitoring of
the amount of time spent active on a daily or weekly basis,
and the approximate intensity of that activity.

To use the analysis function, single click to select a
recording from the recent files list and then click the
“Physical Activity Analysis” button.

10.2 Physical

Activity

Analysis
Once the recording has been opened, the Day Analysis
window will show as below. It allows you to step through
every day of the recording and see the highlighted activity
periods and daily summary data.

€) Day Analysis - User ID: brian - O x

File View Tools Report

Day: 1 . Day: 3 Day: 4 5 /.6 Day: 7
Tuesday Thursday Friday day Monday
22/04/1397 nge7 [N [24r0an1g97 25/04/1997 [V 7 [M]| 270411997 [M]| [28/04r1997 [M]

el L.M i.&l......"

Overview of activity for the cument day (counts per epoch):
T 2700

2025+

1350

=
;
2
£
8

03:00
Activity totals for the cument day:

[l Vigorous: 00:51 [ Moderate: 02:25 [ ]Low: 09:36 [ Sedentary: 04:47 [ Empty: 06:21

Activity results:

Vigorous Activity Time: 00:51:00 Sedentary Activity Time: 04:47:00 Non-zero Time: 15:29:00
Moderate Activity Time: 02:25:00 Empty Time: 06:21:00 Zero Time: 02:10:00
Low Activity Time: 09:36:00 Help...

Calibration {CPM).  Change... ) rv I Recording Mode:  Normal
.[150 =] mins/week
V=1000 7 M=500 / S=50 Target Exercise: mins/ Mourting Postion: Unknown
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Selecting Days

Excluding Sleep Periods

Highlighted Activity Graph

Summary Activity

Definition of Results

To select which day of the recording to view, note the
sequence of small day graphs across the top of the Day
Analysis window. You can click on any of these to view
that day in more detail below. You can also scroll this
selection to view more days later in the recording. Days
which contain some moderate or vigorous activity are
highlighted with the “M” or “V” stamp respectively on the
quick selection view.

Within the View menu, you can choose to exclude sleep
periods from the daytime activity analysis. Note that this
will only exclude time periods explicitly saved as sleep
from the Sleep Analysis function of the software. It will not
automatically detect sleep periods for exclusion from Day
Analysis. However, it is possible to automatically mark for
sleep within a recording from within Sleep analysis (with
some limitations), and then use this function to exclude
those periods.

The main activity graph in the Day Analysis window
highlights periods of constant activity — those where higher
levels of movement are maintained for 10 minutes or more.
You can control whether moderate and vigorous periods
are highlighted in this way using the View menu of this
window.

Below the main activity graph, a bar chart summarises the
amount of time spent in constant activities of vigorous,
moderate or low intensity alongside sedentary time. The
table of results below this includes both the constant totals
drawn in the bar chart and highlighted on the activity graph
(where only 10 minute or greater periods are counted), and
the total times in each category (where every epoch is
counted).

The following tables describe the criteria used when
categorising time expenditure:

Vigorous Activity The total amount of time when
Time the activity count exceeds the
‘Vigorous’ calibration threshold.
Moderate Activity The total amount of time when
Time the activity count is greater than

or equal to the ‘Moderate’
calibration threshold and is less
than ‘Vigorous’ threshold.

Low Activity Time The total amount of time when
the activity count is greater than
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10.3 Set Calibration

or equal to the ‘Sedentary’
calibration threshold and is less
than ‘Moderate’ threshold.

Sedentary Activity The total amount of time when
Time the activity count is greater than
zero and is less than the
‘Sedentary’ threshold.

Empty Time The total amount of time when
the recording did not take place
—such as at the start or end of
the recording (for example the
difference between 00:00 and
the start time or the end time and

24:00).
Non-zero Time Any data within the recording
with a count value above zero.
Zero Time Any data within the recording

with a count value of zero.

If the ‘Show Only Continuous Activity’ option is checked
under the ‘View’ menu, ‘Vigorous Activity Time’ and
‘Moderate Activity Time’ are replaced with:

Continuous Vig. As ‘Vigorous Activity Time’, but

Activity only when the amount of time is
10 minutes or more.

Continuous Mod. As ‘Moderate Activity Time’,

Activity but only when the amount of
time is 10 minutes or more.

It is possible to set the calibration for the intensity of
activity used in classification. This can be done by clicking
the Tools menu on the Day Summary and selecting the
“Set Calibration” function.

The analysis function uses a calibration to derive reference
thresholds for vigorous, moderate, low and sedentary
activity types. These values differ from patient-to-patient
depending on their capabilities, so it is desirable to perform
a calibration for each patient or recording (where
applicable).

The best way to calibrate a recording is to arrange for the
patient to perform a brisk walk (3-4 mph) for at least 5
minutes. This should take place at the start, or at the end
of a recording to ensure that it is easily identifiable when
selecting it in the calibration window [1].

The calibration period can be selected by either clicking
the highlighted period in the activity graph [2], or by
selecting a reported period in the detected periods list [3].
The selected period will use an average of the activity
counts found within the period to produce the moderate
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threshold. This value will also be used to derive the
vigorous and sedentary thresholds. The low threshold
accounts for any values found between the sedentary and
moderate thresholds.

The entire recording will be analysed to detect any bouts of
activity which are longer than 5 minutes and who’s activity
counts are within an acceptable range. These can be
selected as alternative calibration values but they may not
reflect the values of a brisk walk and should be used with
caution. Calibration periods can also be selected manually
by dragging the mouse cursor over a period on the activity
graph, or by entering fixed values in the thresholds fields

[4].

[2] Detected Calibration Period [1] Calibration Window

[——

ﬂ. Set Calibration

Calibration periods/are derived from the patient pefforming a brisk walk for at least 5 minutes.  Fead more
12:09 08/171/201 081120131218

Detected Calibration Periods Thresholds

08/11/2013 1257 - 5 mins @ 800 courts permin = Vigorous Activity:
08/11/2013 1417 - S mins @ 1018 counts per min K -
08/11/2013 14:27 - S mins @ 74 courts permin - — Moderate Activity:
08/11/2013 15:03 - 6 mins @ 807 counts per min .
08/11/2013 15:31 - Smins @ 922 courts permin~ ™ Sedentary Activity: | <=

[3] Detected Calibration List [4] Threshold Fields
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Definition

Physical activity includes everyday activity such as walking and cycling to get
from A to B, work-related activity, housework, DIY and gardening. It also
includes recreational activities such as working out in a gym, dancing, or
playing active games, as well as organised and competitive sport. (See the
Chief Medical Officers' [CMOs'] report.)

National recommendations

The CMOs' current recommendations for physical activity (see UK physical
activity guidelines) state that:

e All adults aged 19 years and over should aim to be active daily.

e Over a week, this should add up to at least 150 minutes (2.5 hours) of
moderate intensity: physical activity in bouts of 10 minutes or more.

e Alternatively, comparable benefits can be achieved through 75 minutes of
vigorous intensity: activity spread across the week or combinations of
moderate and vigorous intensity activity.

e All adults should also undertake physical activity to improve muscle strength
on at least 2 days a week.

e They should minimise the amount of time spent being sedentary (sitting) for
extended periods.

e Older adults (65 years and over) who are at risk of falls should incorporate
physical activity to improve balance and coordination on at least 2 days a
week.

e Individual physical and mental capabilities should be considered when
interpreting the guidelines, but the key issue is that some activity is better
than no activity.

1Moderate-intensity physical activity leads to faster breathing, increased heart
rate and feeling warmer. Moderate-intensity physical activity could include
walking at 3—4 mph, and household tasks such as vacuum cleaning or
mowing the lawn.
2 Vigorous-intensity physical activity leads to very hard breathing, shortness of
breath, rapid heartbeat and should leave a person unable to maintain a
conversation comfortably. Vigorous-intensity activity could include running at
6—8 mph, cycling at 12—14 mph or swimming slow crawl (50 yards per
minute).

NICE Public Health Guidance 44, 2013
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10.4 Weekly
Summary

The Weekly Summary window can be opened through the
Tools menu of the Day Analysis window. It shows a graph
of the wearer’s activity levels over a single week at once:

zar I

File View Options FReport

week: &
Commencing: 091272013
MON 091213 TUE101213  'WED 111213  THU121213  FRI3N2M3 SAT 141213 SUN 151213

ol it il skl btk alll Mk

Variation between daily activity values for cumrent week:

B Continuous Vigorous Activity [ Continuous Moderate Activity || Low Activity — Sedentary Activity

-5

7
£
=
=y
kS
o
E
=

-

0
MON 0912 TUE 10112 WED 1112 THU 1212 FRI1312 SAT 1412 SUN 1512

Totals of activity values detected for cument week:

B Continuous Vig: 06:40  [Jl] Continuous Mod: 12:34  [] Low: 3722 [l Sedentary: 92:12  [] Empty: 00:00

Continuous Vig. Activity: 06:40-00 Sedentary Activity Time: 52-18:00 Non-zero Time: 106:41-00
Cortinuous Mod. Activity:  12-34:00 Empty Time: 00-00-00 Zero Time: 61:19:00
Low Activity Time: 56-28:00

Results:

Help...

Calibration {CPM):  Change... i -
{CFM); g T B 30 : mins/week Recording Mode:
V=729 M=340/ 5=73 Mourting Posttion:

Selecting a Week

The available weeks can be scrolled through in the first
graphic of the Weekly Summary window. Use the scroll bar
at the right to move through the weeks and view the week
of interest.

Note that using the Options menu, the weeks can be
chosen to begin either on Monday (Calendar Week), or on
the first day of the recording (Consecutive Week).

Weekly Summary Graph

The main graph in the Weekly Summary window shows
the time spent in different constant intensity levels on each
day of the selected week. You can see both how the time
each day compares to the target time illustrated by the
black line, and how it varies across the week. For instance,
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the graphic above clearly shows that whilst the target for
moderate activity was missed during most of the week, the
wearer was then very active on Saturday. The View menu
can be used to turn on and off the highlighting of Low,
Medium and Vigorous levels.

Weekly Summary Totals

Below the summary graph, a bar chart illustrates the total
amounts of time spent in each of Vigorous, Moderate and
Low activity, and Sedentary time. Along with the graph
above, this will be updated as the weeks of the recording
are stepped through. The bar graph also shows the target
black line, controlled by the weekly exercise target figure
below it.
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10.5 Totals &
Averages

The Totals & Averages window can be opened through the
Tools menu of the Day Analysis window. This window is
designed to illustrate the variation of activity over the full
length of the recording. The upper graph shows the
changes between weeks, and the lower graph shows the
average variation within weeks.

| & Totals & Averages - Use

File View Options Report

ariation between total activity minutes for each week:

. Continuous Yigorous Activity . Continuous Moderate Activity I:‘ Low Activity = Sedentary Activity
1~ 7200 -
6400 -
5600 -
4800

Time fweek (Mins)

0411 111 1811 28M1 02n2 0w12 1en2 2312 3012 0ei0T 1301 2001 2W01

Average values for totalled weekdays for the entire recording:

. Continuous Yigorous Activity . Continuous Moderate Activity D Low Activity — Sedentary Activity

t

7
£
=
=y
Tz
]
E
=

810
720
630
540
450
360
270
180
20

y

Monday Tuesday Wednesday Thursday Friday Saturday Sunday

Calibration (CPM):  Change... ] bo | rins/weskc Recording Mode:
V=729 | M=340/ S=73 ' z Mounting Position:

Weekly Totals

The upper graph of the Totals & Averages window shows
the total time spent in different activity bands over the
weeks of the recording. In the example shown, the
recording spanned over 6 weeks and showed relatively
steady levels apart from an increase in week 4 and a lower
total in week 6. It is easy to see both the absolute level
versus the target black line (set at the bottom of the
window), and the variation between weeks.

Day of Week Averages

The lower graph of the Totals & Averages window is
produced by averaging each weekday across all weeks of
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the recording. This shows up any variation caused by
weekly patterns of behaviour. In the example shown the
wearer is clearly far more active on Saturday than on an
average weekday, but there is more variation within those
also.

Note that both graphs can be affected by the View and
Options menus. The View menu controls whether
highlights are shown for each of the intensity levels. The
Options menu controls whether the discrete weeks are
considered to always start on a Monday (Calendar Week),
or on the first day of the recording (Consecutive Week).
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11Bulk Export Functions

11.1 Overview

11.2 Bulk Raw Data
Export

11.3 Bulk Results
Export

11.4 Bulk Day
Activity Export

After many individual recordings are collected, it is
sometimes useful to perform a bulk export, when an entire
folder of recording files will be analysed and the results
collated in one step. These functions are available from
within the “Bulk Export” button on the main menu.

This function allows you to export the raw data from every
motion file in a directory into corresponding csv files. It
may be useful if you wish to analyse the data yourself
using a spreadsheet or programming environment rather
than using the MotionWare software.

The Bulk Result Export will export all of the analysed
recordings in a folder, producing a single row of results per
recording. Results where there are multiple periods will
have their results averaged into a single set. This applies
to the Sleep, Day, Nap and NPCRA (if applicable)
functions.

Note: It is recommended to analyse your recordings fully
before using this function for maximum usefulness.
Recordings which have not been analysed will produce
empty results in the export for the particular set(s) of
results.

The Bulk Day Activity Export function will analyse a folder
of recordings using consistent thresholds for physical
activity.

This function may be less accurate than using individually
calibrated threshold levels for each participant to assess
their activity against recommendations, but allows a
consistent comparison across all recordings.

After selecting the options for thresholds of physical
activity, you can also choose:

Minutes of zero data to classify as not-worn: The
software will automatically ignore periods where the watch
was not worn if this option is set. A value of O will disable
the option. A value of 120 (2 hours) will exclude most not-
worn data while being unlikely to occur by accident, even
in elderly or inactive participants.
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Hours of data required in a day to use that day: This
value will select how many hours are required to be worn
in a day in order to include it in the analysis. It allows
participants to avoid wearing the device overnight if their
sleep is not of interest.

Results Separator: This may be either Tab, Space or
Comma. Using a Tab separator will usually make it easier
to paste the results into Excel or analyse with other
software. A Comma separator, or explicitly choosing a
.csv file output, will separate values with commas. This
option should be used with care as it will produce
problematic results with an operating system country set to
use comma symbol as decimal separator.
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12Cloud Data Management (CDM)

12.1 Overview
Our CDM system allows you to securely manage
recordings from multiple sites. It is available as an
additional service which you may add to your account at
any time. Please contact us to find out more information.

Currently the CDM system is only available through the
Windows version of MotionWare software.

The system uses a HQ and Branch model, where the
Branch site(s) will upload their data to our cloud server,
and the HQ site(s) will download the data from our cloud
server.

All data are encrypted using the encryption keys created at
your HQ management site, and is completely secure when
distributed from Branch to Cloud to HQ.

Note: CamNtech has no access to your raw data or
encryption keys at any time. This also means you Must
ensure you keep a backup copy of those encryption keys,
because we cannot recover them.

12.2 HQ/

Management

Site Computer

Configuration
To set up your software as a HQ site, ensure that the
“Show Cloud Data Manager...” option is selected within
the Settings window. Then click the HQ CDM Control
button on the main window to open the HQ window as
shown below.
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HQ Configuration  Branch Configuration  5ync Tools  Help

Open Selected Recording: Sync Folder:

Sleep Analysis |

Filename | User ID Site Name Ste Code Start Time

Day Analysis

4| | »

Total Recordings Found: 0 Reset Columns Clear Cache

Create Encryption Keys

Before any data are transferred over the internet, it must
be encrypted with keys specific to your project. This
function will allow you to create and store those keys. Click
on the HQ Configuration menu and click the Manage
Encryption Keys menu item.

The application uses encryption keys to encrypt any
downloaded recordings priorto uploading them to
the server to ensure secure transmission of the
data. The encryption keys must be created before a
configuration file can be created. It is recommended
to keep backup copies of the encryption keys on a
seperate device such as a USE stick as encrypted
data will become unusable if the orginal encryption
keys are lost.

Curmrent Private Key File:

C:M\Users'David ' App Data“ RoamingWMotionWare  Key
sprivate_20170325_160517 key

Currert Public Key File:

C:M\Users'David ' App Data“ RoamingWMotionWare  Key
shpublic_20170325_160517 key

Create New Encryption Keys...
Open Existing Encryption Keys..

Before any branch can be configured, you must click on
the link to Create New Encryption Keys. Do this now.

When prompted, you should create backup copies of the
encryption keys to keep in order to prevent loss of data. If
you lose the encryption keys, you will lose access to all of
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Enter Login Information

Sync Folder

12.3 Syncing with
Cloud

your data encrypted with them. CamNtech will not be able
to help you read your encrypted data — we do not have
copies of your keys.

Close the Encryption Keys window after creating your new
keys.

You will have been provided with your HQ login
information by CamNtech as part of your purchase. To use
this, first click on HQ Configuration - Login
Information.

I £} Server Login Informatio

Erter your login information for accessing the
server here.

Login 10

|camrrtech

Password:
PROCOOOK

Project Mame:
|test|

Enter all of the fields and click on the Save button. This will
allow the software to connect to the data server as
necessary.

You must also select a folder for the software to store data
on the HQ computer. Click on HQ Configuration - Set
Local Sync Folder in the menu to do so. This folder will
contain all data transferred from the branch sites.

After configuring all of the items above, you may click on
Sync - Sync Now. This should produce no new data in
the list, but no error messages either. This is because
there is no data available yet on the server. Your HQ
system is now configured.

To sync with the Cloud, click the Sync Now menu item in
the Sync menu.

New recordings will be downloaded and decrypted, with a
corresponding entry added to the recordings list as shown
below:
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(@ coM HQ Platiom [PEEER—)

HQ Configuration  Branch Configuration  Sync  Tools  Help

Open Selected Recording: Sync Folder:
| C:\Users\David\Desktop\Decrypted*.

Sleep Analysis

. fleoame. L LserlD ' Slatlins
Day Analysis Wrsit min Wrsit 08/03/2017 14:24

Total Recordings Found: 1 Reset Columns Clear Cache

These recordings can be opened by selecting them in the
recordings list and clicking the Sleep Analysis / Day
Analysis options.

12.4 Branch

Configuration

File
A configuration file is used to automatically configure your
branch computer(s) to sync recordings with the cloud. The
configuration file is created by your HQ site computer and
contains information such as login details and public
encryption key.

Note: a single configuration file can be used on more than
one computer per site but we would recommend using one
configuration file per geographical location.

To create a new configuration file, click the Branch
Configuration menu found on the HQ Manager window,
and the click the Create New Configuration File menu
item. The following window will be shown:
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- &} Create Configuration File

Site Name:

|Papworth

Site Code:

Recordings Folder Location:
[Desklop

Recordings Folder Mame:
|I'v'|arch 2017 Recordings
Destination File Preview:

C:M\Users"David'\Desktop'March 2017 Recordings“PAPD1\Encrypted®
PAPO1_20170:330_103440.mtn.enc

Configuration File Name {without extension):
Papworth_PAFD1

Conrfiguration File Save Folder:
C:M\Users\David\Desktop

Browse...

Overview of fields:

Site Name: provide a name for the site which the
configuration file will be used on.

Site Code: provide a site code used to identify the site’s
recordings when data are synchronised with the HQ site.

Recordings Folder Location: this is location of the
Recordings Folder Name (see below) on the branch
computer where the encrypted recordings will be stored
after they have been downloaded from a MotionWatch.

Recordings Folder Name: this is the name of the folder
inside the Recordings Folder Location where the encrypted
recordings will be stored after they have been downloaded
from a MotionWatch.

Destination File Preview: shows the combined
Recordings Folder Location and Recordings Folder Name
and the folder structure within it.

Configuration File Name (without extension): provide a
file name for the configuration file without an extension.

Configuration File Save Folder: click the Browse... link
to specify a folder to save the configuration file to.

After providing the necessary information, click the Save
button to save the configuration file and create the branch
account on the cloud server.
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£F Please wait..

At this stage, you should transfer the configuration file to
your branch site(s) using your own delivery method (such
as secure email).

12.5 Branch Site
Computer
Configuration
Ensure you have created a configuration file as discussed
in section 11.4.

Loading a Configuration File

First you must ensure that the CDM function is enabled by
selecting the “Show Cloud Data Manager...” option within
the Settings window. Then open the Cloud Data
Configuration window from the main menu CDM Client
Setup button.
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Auto-Upload

Clear Settings

12.6 Synchronising
Recordings
with the Cloud

i €} CDM Branch Configuration

Corfiguration File:

C:Users\David\App Data“RoamingMationWare.
Papworth_PAPQ1 config

Browse...

Configuration Details:

Site Mame: Papworth

Site Code: PAPDT_

Recordings Folder Location: C:\Users'\David'Desktop
Recordings Folder Name: March 2017 Recordings

Login Check:
Login information is OK

Auto-Upload:

ON

Clear Settings

To load a configuration file, click the Browse... button and
select your configuration file using the file selection
dialogue.

The configuration information will be loaded and a
configuration file and login check will be performed. A
green tick will be shown next to the Configuration File
field and one will be shown next to the Login Check field if
these checks succeed.

The Auto-Upload feature automatically uploads new
recordings to the cloud immediately after they have been
downloaded from a MotionWatch.

To turn the feature on or off, click the On/Off buttons.

To clear the currently loaded configuration information,
click the Clear Settings button at the bottom of the
window.

If you are using the Auto-Upload feature, recordings will
automatically be uploaded to the cloud after they have
been downloaded from a MotionWatch.
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If previously downloaded recordings were not uploaded
(such as loss of Internet connection), you can manually
sync them by clicking the Sync Now button on main menu.

The Sync Now button will also open the Sync Status
window:

€8 CDM Sync Status e

Syncing with Cloud
Requesting server file list
Caollating local file list
Checking file Wrsit. mtn.enc.

Uploading file Wrsit mtn enc.
Cloud sync completed successful
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Appendix A - Maintenance and Utilities

Al - The Utilities

Tab
The MotionWatch manager has an additional tab called
‘Utilities’, click on this tab to display a window similar to the
following:

.H‘ MotionWatch

Connected to MWE with Serial Number: 002

Check for Update

Bootloader Ver 03
12
Serial Number
27

3V

Auto Shutdown After Download 7 [ Shutdown Watch

Cument Setup

E:Eﬂ'ter',f L |

This screen shows some technical information about the
MotionWatch:

e Bootloader Ver: This is the version number of part
of the embedded operating software that allows the
MWS8 to be updated remotely.

e Firmware Ver: This is the version number of the
main operating software for the MWS8.

e Serial Number: The watch serial number
Battery voltage: Typically this will show a value
above 3.0V for a new battery and will decline
gradually over the usage period.

¢ Reset Count: Used as debug information — the
number of unexpected reset events.

e Run Time: amount of run time since last battery
change — should reset to zero when a new battery
is fitted.

e Battery Fitted Date: the date that the watch
battery was fitted.
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A2 - Firmware
Update

A3 - Shutdown
Options

The MotionWatch has the ability to be re-programmed
when new features become available. It is always
recommended that the most up-to-date firmware and PC
software are used to avoid possible conflicts and data loss.
To check for an update, select the ‘Utilities’ tab then click
on the ‘Check for Update’ button. The software will provide
a confirmation if an update is available for the
MotionWatch.

To update the firmware, ensure that the MotionWatch is
connected and then click on the ‘Update Firmware’ Button.
Take note of the warning message and click OK if you
wish to proceed.

IMPORTANT: All data and settings will be destroyed by
the firmware update process. Please ensure that any data
has been downloaded before commencing.

WARNING! Do not interrupt the firmware update process —
doing so may damage the MotionWatch which will then
require factory re-programming.

A progress bar will indicate the update progress (this will
take a few seconds).

The MotionWatch will then automatically disconnect, apply
the firmware, then re-connect. The MotionWatch Manager
window will be temporarily closed during this period and
will automatically re-load and show a verification message
upon completion.

Depending upon the type of update, it may be necessary
to manually re-set the MotionWatch. If the MotionWatch
Manager does not re-load automatically, disconnect the
Watch, remove the battery for at least 1 minute, re-fit and
re-connect the USB. The verification message should then
be shown.

The MotionWatch has a low power shutdown function
which will help maximise the life of the battery. In the
utilities windows, there are two options as follows:

e Auto Shutdown After Download: this option
allows the MotionWatch to shutdown automatically
following download. Data in the watch will NOT be
lost but the watch will stop recording. When not
selected, the MotionWatch will continue to record
until its memory is full and then shutdown.

e Shutdown Watch: Allows the watch to be
shutdown manually. Click this button to ensure the
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A4 - Changing the
Battery

watch will be shut down when disconnected from
the USB cable.

The MotionWatch has been designed to facilitate quick
and simple battery changing.

The change the battery, open the MotionWatch
casing as described in Section 1.1 or 1.2 to expose
the USB connection and battery.

Do not connect the USB cable!

Using a suitable tool, carefully push the battery out
from the holder towards the USB connector.

O .

Grasp the battery and withdraw it completely from
the holder.

Wait at least 1 minute or press the marker button
3 times then place a fresh CR2032 battery into the
holder (ensuring correct orientation!) and push
back until fully home.

Note: Data will NOT be lost by removal of the battery.

Observe the LED on the front of the MotionWatch, the
correct start sequence is indicated as follows:

LED stays on for 4 seconds.
LED goes off for 8 to 12 seconds.
LED flashes once.

This sequence is critical to the correct watch operation — if
the LED does not flash, remove the battery and repeat the
process.
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A5 - Waterproof Seal

The MotionWare software will automatically detect that a
new battery has been fitted. If the watch contains data that
has not been downloaded the following message will be
displayed:

r il
MotionWare i

Mew battery detected.
Download data NOW, battery reset will be completed after download

Click ‘OK’ and then download the data from the watch.

To complete the battery replacement process a
confirmation message will be displayed.

r il
MotionWare

Click YES if a new battery was fitted.
Click MO if a new battery was not fitted.

Select ‘Yes’ and the software should display 100% in the
battery life indication. If the new battery is not detected
remove the battery and repeat the steps above taking time
to observe each step. If the battery is not replaced
correctly the watch may stop prematurely with no warning
and the battery life indicator will be incorrect.

The MotionWatch relies upon a rubber O-ring seal around
the top face of the lower part of the casing. The seal
should be periodically checked to ensure that it is correctly
seated, clean and not damaged. (note that some silicone
grease residue will be apparent — do not remove this).
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A6 - MotionWatch
Strap

A7 — Alternative
Mountings

The MotionWatch is supplied as standard with an extra-
long moulded silicone watch strap. The strap is fitted with
two standard 12-14mm watch spring bars. These bars are
spring loaded to allow fitting and removal from the watch
casing (see photo).

=
7 D LOCK
MotionWatch 8

BATTERY TYPE: CR2032

CaA |

-5, www.camntech.com
P

To remove the Strap: Use a flat bladed tool to gently
depress one end of the spring bar by levering against the
side of the casing. Take care not to damage the
MotionWatch casing.

To Fit a Strap: Push the spring bar into the hole through
the strap then place one end of the spring bar into one
hole in the watch casing. Gently depress the exposed end
of the spring bar and then slide into the hole in the casing;
a positive ‘click’ will be heard.

Replacement straps and alternative straps are available
from CamNtech.

It is possible to use any standard watch strap with a 12 to
14mm shoulder with the MotionWatch.

The MotionWatch may be worn at locations on the body
other than the wrist. A range of elasticated straps is
available to allow location on the waist, ankle, thigh or
upper arm. There are also special straps for mounting on
the feet for use with PLMS analysis. These mountings
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A8 — Data Export
Options

require the removal of the watch strap and the use of
special Velcro mounting tabs. These attach using the
same spring bars as the watch straps (see photos).

Velcro Mounting Tabs Fitted

cam Mtech

Fitted to Waist Strap with Adaptor

The MotionWatch data may be exported from for analysis
in third party applications such as MS Excel. To export all
of the Activity and light data as time stamped epoch by
epoch format, first use the ‘Select All' button from the
MotionWise window and then choose the ‘Summary’
option from the ‘Analysis Function’ side bar. Click on the
‘Copy raw data’ button to copy the data to the clipboard.
Now in your external package, select ‘paste’ to paste the
data from the clipboard.

It is possible to use this mechanism with all data (as
explained above) or with any part of the data that is
selected. Use the ‘Select Any’ or ‘Select Days’ buttons to
select the data for export and then follow the same steps
as above.

It is also possible to ‘bulk export’ data directly into .csv text
files (see section 11). In this way, one folder containing
multiple data files can be exported directly to multiple text
format files with a few clicks.
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Appendix B — FAQ & Troubleshooting

What does ‘No data integrity

check’ mean?
The data are protected by a security key which is generated
when the data are originally downloaded. Any changes to the
data after the download (e.g. data corruption, tampering, editing,
daylight saving adjustment) will result in the data integrity check
failure. If a deliberate change has been made, the warning can
be safely ignored. The original data can be restored if required
following any deliberate edit.

Will I lose my data if | fit a new

battery?
The MotionWatch uses non-volatile memory so any data stored
will not be lost if the battery is removed or replaced. Note that
the MotionWatch will automatically shut down when the battery
voltage is low to prevent erroneous data. Always try to download
data BEFORE fitting a new battery. If this fails, fit a new battery
and then download immediately to prevent data loss.

The MotionWatch is not

recognised or will not

communicate:
Ensure that the battery has sufficient charge. If the battery has
run down, the watch will not be recognised when attached to the
USB port. Disconnect from the USB and remove then
refit/replace the battery (see maintenance section for details of
battery changing). Wait at least 1 minute before re-fitting the
battery and observe the correct start-up sequence.

e Some types of Micro USB cable will not make a positive
connection — please use the cable supplied.

e Occasionally the cable connector may become damaged
or worn — try a new USB cable.

The software offers to update

the MotionWatch firmware —

what does this mean?
The MotionWare Software is shipped with the latest device
operating firmware. If the software detects that any MotionWatch
has older firmware, it will inform you that an update is available.
It is recommended that firmware updates are applied to ensure
that you benefit any improvements to the device (see
maintenance section for details of firmware update process).

What are the potential effects

of Electromagnetic

Interference (EMI)?
The MotionWatch is designed and manufactured to minimise the
effects of external EMI upon the device and to minimise the
effect upon the environment from the device. The system
conforms to the appropriate standards with respect to EMI
performance (see Appendix C5). In cases where strong EMI
does affect the MotionWatch, the device will recover with no user
intervention.

MotionWatch & MotionWare User Guide: Issue 1.3.17 Page 84



Can | change the watch strap?
Yes — see Appendix A6 for further information.

| see ‘Device setup re-write’

message when | apply a new

set-up
The MotionWare software will read back the watch set-up and
verify that it is correct. If the verification fails, the following
message will be displayed:

o cohim re-Ante
Vice Selup re-wriie

This indicates that the software is re-trying to write the setup to
the watch. In most cases the re-try will solve the problem and the
message will change to the normal setup confirmation message.
If the setup problem persists then the software will display the
following warning:

[
MotionWare ﬁ

There was a problem with USB communications.
l % You must unplug the watch, and then re-open the software.,

In this case, click ‘OK’ then disconnect the MotionWatch from the
USB. Re-run the software, re-connect the watch and re-apply the
set-up.
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Appendix C — Safety & Environmental Information

C1 - Decontamination

All used devices must be considered to be
contaminated with surface borne bacteria and must
hence be de-contaminated before re-use using a
suitable disinfection and cleaning procedure.

Care must be taken to use the correct de-
contamination procedure and cleaning materials
because long term exposure to certain cleaning
materials is known to attack plastics which can lead
to premature failure of the mechanical integrity of
the medical device casing.

The MotionWatch casing relies upon maintaining
the lubrication of the seals and mating surfaces to
ensure water resistance and to aid opening/closing
of the casing.

CamNtech recommend the use of aqua based
disinfection products and our recommended
products are Clinell® Universal Wipes or Spray.
These products do not contain chemicals known to
cause deterioration of plastics.

Do not use products containing Glutaraldehyde,
Glucoprotamin, Isopropyl, ethyl, or methyl alcohols,
hydrogen peroxide, or bleach products. Do not use
plasma sterilization or ethylene oxide sterilization
procedures, Do not autoclave.

Do not apply self-adhesive labels or tapes to the
casing.

Begin by spraying and/or wiping all visible
surfaces of the closed MotionWatch body and
strap with the cleaning agent. Ensure that all
surfaces are dried before proceeding. Open the
casing to clean only the areas outside of the
waterproof seal (see diagrams below). NOTE - it is
essential not to allow cleaning solutions to enter the
electronics!

Important! — do not clean the O-ring seal as this
removes the lubricant which can make the casing
difficult to open and may reduce the water
resistance. There is no requirement to clean inside
the waterproof area of the casing (see diagrams
below).
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Cleaning the lower casing (strap not shown)

Clean only OUTSIDE of the
red bounded area — do NOT
remove the lubrication from

the O-ring seal.

Cleaning the upper casing

Clean only OUTSIDE of the
red bounded area — do not
clean the vertical side walls
and ensure no cleaning agent
enters the electronics.
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C2 - Battery

C3 - Warnings —

General

C4 - Disposal at End

of Life

B

The device is battery operated and operates at voltages
below 5V DC; there is hence no risk from electric shock.
The battery is user replaceable (see Appendix A4 for
further information).

The battery must be replaced observing the correct
procedure to prevent possible data loss (see Appendix
A4 for further information).

The battery is a standard Coin Cell type CR2032.
Always ensure that the battery used conforms to the
safety standard EN60086-4:2007.

Battery is a swallowing hazard for small children -
do not leave small children unattended when the
device casing is open. Take care when handling and
disposing of coin cell battery.

The MotionWatch is NOT defibrillation proof.

Waste Electrical & Electronic Equipment (WEEE) The EU
requires, under the Waste Electrical and Electronic
Equipment Directive 2012/19/EU that manufacturers
and/or distributors of Electronic and/or Electrical
Equipment manage and pay for the collection and further
handling of WEEE products, as well as provide WEEE-
related information to their customers. CamNtech has
taken the following approach to complying with this
Directive:

CamNtech has registered with an approved Producer
Compliance Scheme (PCS) in accordance with the
requirements of the WEEE Directive.

CamNtech will provide free recycling for all of its WEEE
products when returned to CNT.

CamNtech WEEE products will be designed with
recycling, reuse and waste management as a
consideration.

CamNtech WEEE products will be labelled or stamped
with the WEEE marking in accordance with European
Standard EN 50419.
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C5-EMC
Declaration and
Guidance

The following tables provide a declaration of compliance
and user guidance regarding Electromagnetic (EM)
compatibility of the MotionWatch devices.

Electromagnetic Emissions

Guidance and Manufacturers Declaration —
Electromagnetic emissions
The MotionWatch is intended for use in the electromagnetic
environment specified below. The customer or the user of the
MotionWatch should assure that it is used in such an
environment.
Emissions Compliance Electromagnetic
Tests environment -
guidance
RF Group 1 The MotionWatch uses
Emissions RF energy only for its
CISPR 11 internal function.
Therefore, its RF
emissions are very low
and are not likely to
cause any interference
in nearby electronic
equipment.
RF Class B The MotionWatch is
Emissions suitable for use in
CISPR 11 professional healthcare
and home healthcare
Harmonic Not environments.
Emissions Applicable The MotionWatch has
EN61000-3-2 not been tested for use
in the following special
Voltage Not environments:
Fluctuations / Applicable Military areas.
flicker .
. Heavy Industrial Areas.
emissions
EN61000-3-3 Medicalltrea.tment
areas with high
powered ME
equipment.
Inside the shielded
room of an MRI
system.
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Essential Performance
In severe cases of EM disturbance, the MotionWatch may
be reset and may require intervention within the software
to restart. Recorded data will not be affected. Patient
safety is not affected.

Adjacent Equipment
The MotionWatch normal mode of operation is typically
well spaced from other devices or equipment. The device
should not be operated close to potential sources of EM
disturbance (e.g. a mobile phone).

Connecting Cables
The MotionWatch is supplied with a Micro USB cable of
length 1.8m. Cables exceeding 1.8m are not
recommended and cables exceeding 3m are prohibited.

WARNING: Use of cables and/or accessories other than
those specified by CamNtech may result in increased
electromagnetic emissions or decreased electromagnetic
immunity and result in improper operation.

You may also need to use an adaptor if your Mac or PC
laptop only has USB-C ports, and not rectangular USB-A.
In this case you should still connect the cable supplied by
CamNtech between the output end of the adaptor and the
MotionWatch.

Use adjacent to Portable RF Communications equipment
WARNING: Wireless communications equipment such as
wireless home network devices, mobile phones, cordless
telephones and their base stations and walkie-talkies
should be used no closer than 30 cm (12 inches) to any
part of the MotionWatch, including cables specified by the
manufacturer. Otherwise, degradation of the performance
of this equipment could result.
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Electromagnetic Immunity

Guidance and Manufacturers Declaration — Electromagnetic

Immunity

The MotionWatch is intended for use in the electromagnetic environment
specified below. The customer or the user of the MotionWatch should
assure that it is used in such an environment.

Immunity IEC 60601 Compliance Electromagnetic
Test Test Level Level environment -
guidance
Radiated IEC61000- 10 V/m 80- The MotionWatch is
Field 4-3 2700 MHz suitable for use in
Immunity 1 kHz 80% am professional
healthcare and
9-28 V/m 385- home healthcare
IEC61000- 6000 MH environments.
4-3 pulse mode
Electrostatic | IEC 61000- | +/-8kV Contact
Discharge 4-2
(ESD)
+/-15kV Air
'4EZC 01000~ 1 1e¢ 61000-
4-2

The MotionWatch is not mains powered hence no ac
power line tests are applicable.
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Appendix D — Technical Specifications

Specifications

Functional Specifications

Sizemm: | MW 8 36(I) x 28.2(w) x 9.4(d) excluding strap
MW R 42.7(l) x 32.8(w) x 11.5(d) excluding strap
Weight: | MW 8 9.1 grams (including battery, excluding strap)

MW R 19.5 grams (including battery, excluding strap)

Accelerometer: Tri-axial, MEMs technology. 0.01g to 8g range, 3 — 11Hz

Battery: CR2032 Lithium Coin Cell

Battery Life: 3 Months run time*; simple user change

Memory: 4Mbits non-volatile (91 days recording @ 1min epoch —
activity and light, uncompressed)

Waterproof: IPX7 - up to 1 hour at 1m (suitable for swimming)

Marker button: MW 8: Yes — with visual feedback. MW R: No

Epoch: 1, 2, 5, 15, 30, 60 seconds

Comms: Direct USB, Plug & Play drivers, Micro USB cable.

Download: All data in a maximum of around one minute.

Strap: Bespoke XL 12mm silicone (245mm overall length) or 12mm

nylon. MotionWatch R has various mounting options

Light Sensor Specifications (not fitted to MotionWatch R)

Type: Digital — human eye response optimized.
Range: Automatic ranging; 0 to 64000lux
Resolution: 0.25lux (0-1000 lux range)

1.00lux (1000-4000 lux range)
4.00lux (4000-16000 lux range)
16.0lux (16000 — 64000 lux range)

Sampling: 1 sample per second — averaged over epoch

*Applies to MotionWatch Mode, Tri-Axial Mode is 60 days. Battery performance can be
significantly reduced during low temperature operation.

Operating & Storage Conditions

Complies with the requirements of EN60601-1-11:2010

Operating Storage

Temperature +5°C to + 40°C -25°C to +70°C
Relative Humidity 0 to 93% 0 to 93%
Atmospheric Pressure 70kPa to 106kPa 70kPa to 106kPa
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Accelerometer Processing

Raw acceleration measurements are processed by the on-board software of the
MotionWatch to produce a quantitative measure of the activity during each epoch.
This is a four stage process which is applied to the accelerometer data:

1. The channel perpendicular to the watch is separated and subjected to the
bandwidth filtering specified above (3-11Hz).

2. The peak acceleration (either positive or negative) during each second is
recorded.

3. This is compared to a minimum “not moving” threshold of approximately 0.1g.
Values below this threshold are ignored to simplify the final activity graph.

4. The result from each second is summed over the epoch and scaled to
produce a standard result in controlled jig testing. This value is then recorded
as the MotionWatch count for the epoch.

Sensitive in this
direction

This process is illustrated in the diagram below, showing the acceleration waveform
over two epochs, each containing two seconds of data.

one second

v

P
<«

VY “"V’“\_/

+35 +40 -25 -30
\— A /
v Y
First 2 second epoch Second 2 second epoch
35+40=175 25+30=55
75 MW counts 55 MW counts
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Tri-Axial Mode Data Processing

This is similar to above except all three axes are utilized to form counts based upon a
peak vector magnitude.

1.
2.
3

The X, Y and Z axes are sampled with filtering at 3-11Hz.

The peak X2 + Y2 + Z2 value is tracked.

At the end of each second, the square root of the peak value from that
second is calculated.

This is compared to a minimum “not moving” threshold of approximately 0.1g.
Values below this threshold are ignored to simplify the final activity graph.
The result from each second is summed over the epoch and scaled to
produce a standard result in controlled jig testing. This value is then recorded
as the ‘Tri-Axial count’ for the epoch.

The diagram below shows the X, Y, Z orientation relative to the watch casing:

MotionWatch XYZ axes: Tri-Axial mode

MotionWatch & MotionWare User Guide: Issue 1.3.17 Page 94



Appendix E — Utilities

E1l - CSV Import
Utility

To allow import of data recorded with the Actiwatch Spectrum
or Actiwatch 2, a CSV import utility is provided. Note that this
import utility is only available for Windows, not Mac.

Three steps are required to import the data:

1.

2.

Step 1 — Export the CSV

Step 2 — Convert the CSV Data

Export the data in CSV format from the Actiware
Software.

Load the CSV into the utility and perform the
conversion.

Load the resulting AWD file into MotionWare.

In the Actiware Software, select new analysis and then
click the Actogram button to show the graph of the
required data.

Next set up the Actiware report generation (you should
only need to do this once).

From the tools menu, select ‘options’ and then click on
the export tab. Ensure that the ‘full header’ and ‘epoch-
by-epoch list’ options are checked.

Now click the ‘data list’ tab and ensure that the ‘activity
option is checked.

Click OK to save and close the options window.

From the main file menu, select the ‘export...” option —
ignore the ‘reminder’ pop-up.

You can now choose the file name and location and
then save the export data as a csv file.

Run the MotionWare CSV Import utility from the
Windows Start menu:

Mixed Reality Portal

2 Mobile Plans

l Mono

(3\) MotionWare

W MotionWare CSV Import

l’ Mozilla Thunderbird

N

Notepad++

=l
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e Click on the ‘Load CSV file’ button.

B CSV Import Rev 1.0.1 =

" Load C5vFle | Fie Nare |

User 1D ‘

Gender ’7

fhge al Start of recording ’7
Start Date ’7

Start Time ’7

Epoch ’7

File: Name ‘

e Browse to locate the CSV file saved in step 1 and click
‘Open’

e The user ID, Gender etc. from the exported CSV file
should be displayed.

¢ Confirm that the recording details are correct in the
display.

o If the details are not correct, the export may not be in
the correct format — please ensure the correct settings
were applied in Actiware for CSV export.

¢ Click ‘Save AWD'’ to generate the output file.

Step 3 — Load the AWD File

e Use the MotionWare software to browse for the AWD
file created in step 2. (Note you will need to change the
file type’ to .AWD to see the files):

hd [Motion (*.mtn] v]
Maotion (*.mtn)

—_—

Actiwatch Fast (*.AWF)

e Load the AWD file
The data may now be analysed and re-saved as
required.
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Document Revision History

Issue Issue Date Description By
From To
1.0.20b | 1.0.22 14/01/14 | Updated screenshots and added instructions for new View options and Editing Data TE
1.0.22 1.0.22a | 31/01/14 | Updated battery replacement procedure in section A5 HS
1.0.22a 1.0.27 24/04/14 | Changed Battery Life, added section for nap analysis HS
1.0.27 1.0.27a | 25/06/14 | Corrected battery gauge info, corrected sleep epoch recommendation HS
1.0.27a 1.1.2 30/09/14 | Added new reporting options and data compression details. HS
1.1.2 1.1.5 22/10/14 | Added Daytime Analysis section TE
1.1.5 1.1.9 11/03/15 | Tweaked Day Analysis section, added updated screenshots and calibration info DW
1.1.9 1.1.15 28/05/15 | Added Tri-mode, mounting locations + straps and misc. software revisions HS
1.1.15 1.1.15a | 07/07/15 | Corrected email contact for E Van Someren in NPCRA section HS
1.1.15a 1.1.20 17/11/15 | Updated battery life info and battery fitted date to coincide with V1.1.20 SW HS
1.1.20 1.1.21 13/01/16 | Added ‘Definition of Result’ sub section which describes each day analysis result in detail. DW
1.1.21 1.1.25 29/06/16 | Updated for V1.1.25 software and V03.20 firmware release HS
1.1.25 1.1.25a | 22/09/16 | Added coin cell warning, updated accelerometer processing and CSV export sections. HS
1.1.25a | 1.1.25b | 01/11/16 | Added join files, daylight saving and restore data instructions HS
1.1.25b | 1.1.39 07/02/17 | Updated descriptions of Zero/Non-zero data. DW
1.1.39 1.2.1 30/03/17 | Updated Day Analysis section, added CDM section DW
1.2.1 1.2.5 02/05/17 | Updated de-contamination advice HS
1.2.5 1.2.6 06/07/17 | Added sub-section for Bulk Result Export DW
1.2.6 1.2.14 | 01/12/17 | Added Average light level measurement TE
1.2.14 1.2.22 | 26/02/18 | Added battery advice page (p4), improved battery replacement advice throughout, revised HS
cleaning advice, updated misc screen shots and minor detail changes.
1.2.22 1.2.22a | 05/03/18 | Added export options to appendix A8. Clarified installer information HS
1.2.22a 1.2.23 23/03/18 | Added Central Phase Measure to sleep statistics TE
1.2.23 1.2.25 23/07/18 | Updated for V1.2.25 release, updated battery life in tri-mode, added rugged model. HS
1.2.25 1.2.26 23/08/18 | Updated HC information. HS
1.2.26 1.2.26a | 14/02/19 | Updates for MDR review, Updated SW installation instructions HS
1.2.26a 1.2.28 11/09/19 | Added section 5.15 to describe the ‘combine epochs’ function. Updates to meet requirements HS/MD
of Medical Device Regulation EU 2017/745. Updated EMI/EMC compatibility information.
1.2.28 1.2.35 13/11/19 | Updated to include Auto-Sleep analysis instructions. TE
1.2.35 1.2.36 27/11/19 | Updated CamNtech address, removed Windows 7 HS
1.2.36 | 1.2.36a | 03/12/19 | Updated table of contents (missed from issue 1.2.35) HS
1.2.36a 1.2.42 01/03/20 | Added section 5.16 for Temperature data import TE
1.2.42 1.2.44 29/05/20 | Clarified description of tri-axial counts to the same wording as uniaxial for latter stages TE
1.2.44 1.2.46 03/06/20 | Updated battery life indications and battery gauge to match software HS
1.2.46 1.2.47 11/06/20 | Added NPCRA edit instructions to section 7. HS
1.2.47 1.3.12 11/09/20 | Added specific notes for Mac version installation and where appropriate elsewhere. Updated TE
main menu and other screenshots with significant changes.
1.3.12 1.3.16 24/11/20 | Update user manual to include EU Authorised Representative details. HS
1.3.16 1.3.17 | 06/01/21 | Minor updates following EC Rep review HS
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